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1. Safety

Safety Setup

Brooks uses caution, warning, and danger labels to convey critical information required for the safe
and proper operation of the hardware and software. Read and comply with all labels to prevent
personal injury and damage to the equipment.

               Read the Safety Chapter

Failure to review the Safety chapter and follow the safety warnings can result in serious
injury or death.
l All personnel involved with the operation or maintenance of this product must read

and understand the information in this safety chapter.

l Follow all applicable safety codes of the facility as well as national and
international safety codes.

l Know the facility safety procedures, safety equipment, and contact information.

l Read and understand each procedure before performing it.

Authorized Personnel Only

This product is intended for use by trained and experienced personnel. Operators must comply with
applicable organizational operating procedures, industry standards, and all local, regional, national,
and international laws and regulations.
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Explanation of Hazards and Alerts

This manual and this product use industry standard hazard alerts to notify the user of personal or
equipment safety hazards. Hazard alerts contain safety text, icons, signal words, and colors.

Safety Text

Hazard alert text follows a standard, fixed-order, three-part format.

l Identify the hazard

l State the consequences if the hazard is not avoided

l State how to avoid the hazard.

Safety Icons
l Hazard alerts contain safety icons that graphically identify the hazard.

l The safety icons in this manual conform to ISO 3864 and ANSI Z535 standards.

Signal Words and Color

Signal words inform of the level of hazard.

Danger indicates a hazardous situation which, if not avoided,will result
in serious injury or death.

The Danger signal word is white on a red background with an
exclamation point inside a yellow triangle with black border.

Warning indicates a hazardous situation which, if not avoided, could
result in serious injury or death.

The Warning signal word is black on an orange background with an
exclamation point inside a yellow triangle with black border.

Caution indicates a hazardous situation or unsafe practice which, if not
avoided,may result in minor or moderate personal injury.

The Caution signal word is black on a yellow background with an
exclamation point inside a yellow triangle with black border.

Notice indicates a situation or unsafe practice which, if not avoided,may
result in equipment damage.

The Notice signal word is white on blue background with no icon.
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Alert Example

The following is an example of a Warning hazard alert.

Number Description

1. How to Avoid the Hazard

2. Source of Hazard and Severity

3. General Alert Icon

4. Signal Word

5. Type of Hazard

6. Hazard Symbol(s)
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General Safety Considerations

               Software

Software is not safety rated. Unplanned motion can occur as long as power is
supplied to the motors. Maximum torque could be momentarily applied that may
cause equipment damage or personal injury.
l Only operate the robot with its covers installed.

l Guarantee that safety controller features are in place (for example, an
emergency stop button and protective stop).

l Regularly test safety components to prove that they function correctly.

               Robot Mounting

Before applying power, the robot must be mounted on a rigid test stand, secure
surface, or system application. Improperly mounted robots can cause
excessive vibration and uncontrolled movement that may cause equipment
damage or personal injury.
l Always mount the robot on a secure test stand, surface, or system before

applying power.

               Do Not Use Unauthorized Parts

Using parts with different inertial properties with the same robot application can
cause the robot’s performance to decrease and potentially cause unplanned
robot motion that could result in serious personal injury.
l Do not use unauthorized parts.

l Confirm that the correct robot application is being used.
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               Magnetic Field Hazard

This product contains magnetic motors that can be hazardous to implanted
medical devices, such as pacemakers, and cause personal harm, severe injury,
or death.
l Maintain a safe working distance of 30 cm from the motor when with an

energized robot if you use a cardiac rhythmmanagement device.

            Unauthorized Service

Personal injury or damage to equipment may result if this product is operated or
serviced by untrained or unauthorized personnel.
l Only qualified personnel who have received certified training and have the proper

job qualifications are allowed to transport, assemble, operate, or maintain the
product.

             Damaged Components

The use of this product when components or cables appear to be damaged may cause
equipment malfunction or personal injury.
l Do not use this product if components or cables appear to be damaged.

l Place the product in a location where it will not get damaged.

l Route cables and tubing so that they do not become damaged and do not present
a personal safety hazard.

             Inappropriate Use

Use of this product in a manner or for purposes other than for what it is intended may
cause equipment damage or personal injury.
l Only use the product for its intended application.

l Do not modify this product beyond its original design.

l Always operate this product with the covers in place.
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             Seismic Restraint

The use of this product in an earthquake-prone environment may cause equipment
damage or personal injury.
l The user is responsible for determining whether the product is used in an

earthquake prone environment and installing the appropriate seismic restraints in
accordance with local regulations.

Mechanical Hazards

             Pinch Point

Moving parts of the product may cause squeezing or compression of fingers or hands
resulting in personal injury.
l Do not operate the product without the protective covers in place.

                Automatic Movement

Whenever power is applied to the product, there is the potential for automatic or
unplanned movement of the product or its components, which could result in personal
injury.
l Follow safe practices for working with energized products per the facility

requirements.

l Do not rely on the system software or process technology to prevent unexpected
product motion.

l Do not operate the product without its protective covers in place.

l While the collaborative robotics system is designed to be safe around personnel,
gravity and other factors may present hazards and should be considered.
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             Vibration Hazard

As with any servo-based device, the robot can enter a vibratory state resulting in
mechanical and audible hazards. Vibration indicates a serious problem. Immediately
remove power.
l Before energizing, ensure the robot is bolted to a rigid metal chamber or stand.

Electrical Hazards

Refer to the specifications of theGuidance Controller Quick Start Guide for the electrical power.

               Electrical Shock Hazard

Contact with electrical power can cause personal harm and serious injury.
l To avoid electrical shock, disconnect the power before troubleshooting the

electrical components.

l Check the unit's specifications for the actual system power requirements and use
appropriate precautions.

l Never operate this product without its protection covers on.

               Electrical Burn

Improper electrical connection or connection to an improper electrical supply can result
in electrical burns resulting in equipment damage, serious injury, or death.

l Always provide the robot with the proper power supply connectors and ground that
are compliant with appropriate electrical codes.
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               Electrical Fire Hazard

All energized electrical equipment poses the risk of fire, which may result in severe injury
or death. Fires in wiring, fuse boxes, energized electrical equipment, computers, and
other electrical sources require a Class C extinguisher.
l Use a fire extinguisher designed for electrical fires (Class C in the US and Class E

in Asia).

l It is the facility's responsibility to determine if any other fire extinguishers are
needed for the system that the robot is in.

Improper handling of the power source or connecting devices may cause component damage or equipment fire.
l Connect the system to an appropriate electrical supply.

l Turn off the power before servicing the unit.

l Turn off the power before disconnecting the cables.

Ergonomic Hazards

             Heavy Lift Hazard

Failure to take the proper precautions before moving the robot could result in back injury
and muscle strain.
l Use a lifting device and cart rated for the weight of the drive or arm.

l Only persons certified in operating the lifting device should be moving the product.

             Tipover Hazard

This product has a high center of gravity which may cause the product to tip over and
cause serious injury.
l Always properly restrain the product when moving it.

l Never operate the robot unless it is rigidly mounted.
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             Trip Hazard

Cables for power and communication and facilities create trip hazards which may cause
serious injury.
l Always route the cables where they are not in the way of traffic.
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Emergency Stop Circuit (E-Stop)

The integrator of the robot must provide an emergency stop switch.

               Emergency Stop Circuit

Using this product without an emergency stop circuit may cause personal injury.

l Customer is responsible for integrating an emergency stop circuit into their
system.

l Do not override or bypass the emergency stop circuit.

Recycling and Hazardous Materials

Brooks Automation complies with the EU Directive 2002/96/EUWaste Electrical and Electronic
Equipment (WEEE).

The end user must responsibly dispose of the product and its components when disposal is
required. The initial cost of the equipment does not include cost for disposal. For further information
and assistance in disposal, please email Brooks Automation Technical Support at support_
preciseflex@brooksautomation.com.

10 Copyright © 2024, Brooks Automation

mailto:support_preciseflex@brooksautomation.com
mailto:support_preciseflex@brooksautomation.com


Brooks Automation 2. Introduction
Part Number: 608329 Rev. A System Introduction

2. Introduction

System Introduction

Guidance Dispense (GD) is a set of hardware and software components that can be utilized to
implement a complete automated dispensing system. When these components are integrated with
a robot and combined with syringes and needles, they can automatically dispense adhesives,
sealants and other fluids along both simple and arbitrarily complex paths. Path programming is
performed using simple teach-and-repeat methods that can be augmented by machine vision to
automatically correct for deviations in part position and orientation.

Since dispensing encompasses an extremely wide range of requirements, Guidance Dispense has
been designed as a very open system that permits hardware and software components to be
tailored for the application. While GD has been designed for use with the PrecisePlace Cartesian
robots, GD can be employed with any robot that is controlled by a PreciseFlex Guidance Controller.
As appropriate, the GD software can be coupled with 3rd party hardware or the GD hardware could
be employed without the GD software. For simple dispensing applications, a user can purchase just
the PrecisePlace robot with the simple GD fixed syringe holder and the GD software and supply
their own air dispenser, syringes, needles, and air plumbing.

In this manual, it is assumed that the full set of Guidance Dispense hardware and software
components are being utilized, but this is only done to simplify the manual. Skip those sections of
the manual that do not apply to the specific system configuration at hand.

The Guidance Dispense hardware consists of the following:

l A dual control air dispenser that can drive two syringes

l A simple fixed position syringe clamp

l A second syringe clamp that moves on a vertical slide under pneumatic control and includes a contact
sensor

l An arm mounted camera that includes a variable intensity ring light

The dual air dispenser includes two regulators for controlling the air pressure that forces out the fluid
in the syringes as well as two additional regulators for controlling vacuum for quickly releasing the
pressure on the syringes. The air dispenser housing includes buttons with lights as a teaching aid
and to indicate system status. The air dispenser solenoids, buttons and lights, pneumatic clamp
piston, and contact sensor are all interfaced to the robot's controller to permit automatic operation.
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The Guidance Dispense software is an open source package that executes on any Guidance
Controller. In the case of the PrecisePlace robot, this software executes in a controller that is
integrated into the back of the robot's X-axis. The operator interface is implemented as a series of
web pages that can be viewed locally or remotely via a web browser. This software permits
dispensing paths and processes to be taught and executed without the need for programming. The
graphical user interface provides all of the tools for teaching straight and curved three-dimensional
paths and controlling the operation of the two syringes. The system includes an operator control
panel and run-time that permits paths to be played back while maintaining excellent speed control to
enable consistent results.

GD also supports PreciseVision for performing vision-guided path dispensing. This permits a
camera mounted above the work area or on the end of robot to locate objects or fiducial marks and
to utilize the detected positions and orientations to automatically update dispensing paths. This
reduces the need for complex fixtures and allows for a more flexible approach to dispensing.
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3. Setup, Installation, and Execution

Interfacing a Robot to a PC

All of the software and data necessary to teach and execute a dispensing process (with the
exception of machine vision) resides on the robot's controller. However, a PC is utilized as the
graphical user interface (GUI) for the Guidance Dispense software. Except for one-time system
setup procedures, the only application software required on the PC is a standard web browser. For
the best results, it is suggested that the user use the following PC equipment for a non-vision
system:

l A 500 MHz or faster PC running a Windows XP or later system

l Microsoft Edge version 6.x or later

l A 10/100 Ethernet card

l A standard Cat-5 Ethernet cable

If the user's system includes PreciseVision, the vision software will be executed on the PC. In this
case, the recommended equipment is the following (see the PreciseVision manual for additional
information on cameras and installation of the PreciseVision software):

l A 2.3Ghz or faster Pentium 4 PC running a Windows XP or later system

l Microsoft Edge version 6.x or later

l Gigabit Ethernet (recommended and required for certain cameras), otherwise 100Mb Ethernet interface

l A standard Cat-5 Ethernet cable

l 512 MB of RAM

l At least 1 GB of space on the PC's disk

l A 2x CD-ROM drive interfaced to the PC or access to the Brooks Support website

To connect the robot’s controller to a PC, perform the following steps:
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Step Action

1.

Connect the robot's controller to the PC directly or via a hub or switch using the appropriate cable as
described above.

Before operating your robot, ensure that the following steps have been
performed: (1) the robot has been properly mounted; (2) all required
safety interlocks have been installed and tested; and (3) power has been
connected. For the PrecisePlace robots, this information is provided in
the PrecisePlace 2300/2400 Robot, Hardware Introduction and
Reference Manual.

2.

If utilizing a PrecisePlace robot, the Ethernet cable is plugged into either of the sockets on the right end-
cap of the robot, as shown.

Set the IP address and subnet mask on the PC to be compatible with the controller. By default, the
controller’s IP address is 192.168.0.1 and the subnet mask is 255.255.255.0. If not familiar with the
procedure for changing the IP address and subnet mask on the PC, see the next section. Alternately,
the user can utilize the Guidance Discovery application to set the controller's IP information to be
compatible with the PC.

For instructions on the use of the free Guidance Discovery utility, see the "Guidance Discovery"
chapter of the "Guidance Development Suite" section of the PreciseFlex Library.
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Setting the IP Address in Windows

This section provides detailed instructions if the user requires assistance in configuring their PC’s IP
address and subnet mask to be compatible with the robot's controller. If the IP address has already
been changed and subnet mask on their PC is compatible, skip this section.

By default, the Guidance Controller is factory configured with the IP address/subnet mask of
192.168.0.1 and 255.255.255.0. The PCmust be compatible with this IP specification. For Windows
users, complete the following steps:

Step Action

1. Open the PC control panel by clicking Start > Settings > Network Connections.

2.

Right-click on the icon for the Ethernet card that is connected to the controller and select Properties.
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Step Action

3.

Highlight Internet Protocol (TCP/IP) and click Properties.

4.
If the PC is using DHCP and is not compatible with the controller, the user must specify a compatible
IP address and subnet mask. Click the Use the following IP address radio button and enter IP
information that is compatible. Once connected to the controller, change the IP address and subnet
mask of the controller to be compatible with the network.

5.

If the PC is using a static IP address the user does NOT need to change the IP address and subnet
mask. Instead, click Advanced.

6. Click Add and enter in a compatible IP address and subnet mask. For example, 192.168.0.200 and
255.255.255.0.

7. ClickOK to activate the changes.
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Guidance Dispense Software Installation

To use the Guidance Dispense software package and it has not been pre-installed on the robot's
controller, or to upgrade GD software to a new version, this section describes the software
installation and upgrade process.

The GD software is an open source application that consists of a GPL "project" and a set of custom
web pages. This information is contained in a collection of disk files that must be loaded into the
robot controller's flash disk in the "/flash" directory. For simplicity, all of the required files are
distributed in a single compressed .zip file.

To successfully install a new version of GD, the following is required:

l A distribution copy of the GD software. This file is typically named "GD_Version_xxx.zip."

l A copy of the Guidance Develop Suite (GDS) version 1.4 or later installed on your PC. For this
procedure, it is not necessary to purchase a licensed copy of GDS since the installation utility will
operate without a license.

l A PC with a suitable browser interfaced to the robot's controller via Ethernet.

l At least 1.5MB of free space available on the robot controller's flash disk.

l A copy of GPL version 1.3 or later executing on the robot's controller. GPL is the motion control system
software that is provided with each PreciseFlex Guidance Controller.

To install the new Guidance Dispense software, complete the following steps:

Step Action

1.

Copy the Guidance Dispense distribution file to the PC's hard drive and uncompress the zip file.

Recent versions of the Windows operating system provide built-in utilities for uncompressing zip disk
files. Typically, if the user right-clicks on a zip file, they will see an "Extract all" option. If the version of
Windows does not include this feature, they can obtain a free version of an UnZip utility from multiple
sites on the Internet.

Once the GD distribution is uncompressed, the user can execute the "Guidance Web Install Wizard" to
copy all of the files to the robot controller. This utility is part of the Guidance Development Suite. During
the installation of the application, if an existing installation of a web-based application is detected, the
wizard will prompt the user to replace this with the new application.
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Step Action

2.

To launch the installation application, click Start→Programs→PreciseFlex Automation→GDS
x.x→Guidance Web Install Wizard.

3. Follow the instructions of this wizard to install the Guidance Dispense application.

4.

Provide the directory path and name of the file that contains the load instructions for the installer. For
GD, this file is named "GuidanceDispense.gwa" and will be located in the top-level directory of the
unZipped files.
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Step Action

5.

Ensure that the IP address is correct and click Next.

6.

The wizard may take a few minutes to complete the process.
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Step Action

7.

Click Finish Setup.

8. Once the wizard is completed, restart the robot's controller to begin execution of the Guidance
Dispense application.

Starting the Guidance Dispense Application

As a configuration option for the robot's controller, each time the controller is restarted, the
Guidance Dispense Application can be automatically executed and the web pages redirected to the
GD application pages.

Step Action

1. To access the Guidance Dispense Application user interface, start the robot's controller by turning on
the robot's AC power.
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Step Action

2.

On the PC interfaced to the controller via Ethernet, launch a browser and enter the IP address of the
robot's controller. By default, the controller's IP address is set to 192.168.0.1.

If Guidance Dispense and its web pages have been automatically started, the following web page will
be displayed within the browser. The background image is the GD Operator Control Panel. In the
foreground is a pop-up window that identifies the version of the GD software.

3.

If this web page does not appear, refer to theGuidance Controller Setup and Operation, Quick Start
Guide for instructions for loading and executing a GPL project. The project to be loaded and executed
should be on the controller's flash disk and be named "Gdispense." If the software cannot be located,
or to automatically start the GD, execute the software installation process described in "Guidance
Dispense Software Installation" on page 17 and select the auto start options on the final screen. Once
able to view the start-up pages for GD, continue with the remainder of this section.

4. Click the Continue button to dismiss the Guidance Dispense version identification pop-up window.
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Step Action

5.

If this is the first time that the GD application is being executed, you will see the following error pop-up
message that indicates that the "Safe Point" has not been taught. You will also see a number of errors
listed in the "Systems Messages" area that indicate that other data has not yet been defined.

6.

ClickOK to ignore this error for now and select No when you are asked to teach this position. The
"Safe Point" will be discussed in later sections of this manual.

You should now see the following Operator Control Panel screen that indicates that the Guidance
Dispense application has been successfully started and is now operational.
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Before operating a robot, ensure that the following steps have been performed: (1) the
robot has been properly mounted; (2) all required safety interlocks have been installed
and tested; and (3) power has been connected. For the PrecisePlace robots, this
information is provided in the PrecisePlace 2300/2400 Robot, Hardware Introduction and
Reference Manual.

Copyright © 2024, Brooks Automation 23



4. Hardware Introduction Guidance Dispense System
Guidance Dispense Hardware Overview Part Number: 608329 Rev. A

4. Hardware Introduction

Guidance Dispense Hardware Overview

This chapter describes how to operate and adjust the Guidance Dispense hardware components
after they have been mounted and interfaced to a robot and the Guidance Dispense software has
been installed on the robot's controller. For individuals who require an in-depth understanding of the
this hardware and for those who want to configure a robot system with these components, detailed
descriptions of the GD hardware are provided in Chapter 4: Reference Information.

Figure 4-1 illustrates a full-featured PrecisePlace 1300 (3-axis XYZ) robot that includes all of the
Guidance Dispense hardware components. With the addition of loaded syringes with needles and a
PC interfaced via Ethernet, this equipment would be ready to apply to a vision-guided dispensing
application.

Figure 4-1: PrecisePlace 1300 (3-Axis XYZ) Robot
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               Electrical Shock Hazard

The robot's controller and power supplies are located beneath the X-axis cover. These
units are open frame electrical devices that have exposed unshielded high voltage pins,
components and surfaces. In addition, the motor power supply provides 320VDC volts to
the motors and takes about two minutes to bleed down after power is disconnected. AC
power to the robot must be disconnected prior to removal of the X-axis cover for any
reason.

Mounted on the Z-axis of the robot are the following:

l The dual control air dispenser

l A sliding syringe clamp with a Z-Contact sensor

l A fixed position syringe clamp

l An arm-mounted downward looking camera with a variable intensity ring light

This system dispenses fluids by applying air pressure to a plunger within a syringe. This air
pressure must be provided by an external source that is connected to an air intake fitting mounted
on the robot's right end-cap. The air line is routed through the interior of the robot and the Z-axis E-
chain and terminates at a fitting in the right side of the air dispenser. The dual control air dispenser
regulates and manages the airflow and provides two output air lines, one for each of two possible
syringes held by the two syringe clamps.

If the system is equipped with the machine vision option, the camera can either be attached to a
stationary mount above the robot or can be mounted to the Z-axis of the robot as pictured in Figure
4-1. The benefit of a stationary mount is that a picture can be taken while the robot has moved
away. The benefit of an arm-mounted camera is that a higher resolution, smaller field of view lens
can be selected and the camera can be repositioned in the workspace as required.

If an arm-mounted camera is utilized, the DC power for the camera and the light are provided at the
Z-axis. The Ethernet cable that is connected to the camera is routed through the interior of the robot
and its signals are available on the robot's right end-cap.

The next sections of this chapter provide instructions on operating and adjusting the hardware
components.

Dual Control Air Dispenser

The Dual Control Air Dispenser drives the air lines for the two syringes and the pneumatic actuator
for the sliding syringe clamp. In addition, this device has back-lit buttons that greatly simplify
teaching path "nodes" and that display the system execution state when a path is being executed.
Figure 4-2 illustrates the key elements of this device.

Copyright © 2024, Brooks Automation 25



4. Hardware Introduction Guidance Dispense System
Dual Control Air Dispenser Part Number: 608329 Rev. A

Figure 4-2: Dual Control Air Dispense

For each syringe, this device provides two pressure regulators: one to control the positive pressure
that forces the syringe plunger to dispense fluid, and a second regulator that supplies air to a venturi
device that creates a vacuum in the syringe air line when the positive pressure is turned off. The
vacuum assists in backing off the syringe plunger to minimize dribbling of the dispensed fluid.

Each of these regulators can be adjusted from 7 PSI up to 100 PSI. An adjustment screw is
available through a hole that is above each of the miniature pressure regulator meters.

NOTE: To avoid accidental changes in the pressure settings, the air pressure screw
adjustments normally have a locking nut engaged. To release the lock nut, remove
the cover of the air dispenser and loosen the nut.

NOTE: The positive pressure for each syringe should be adjusted to provide the
desired flow rate of dispensed material. If the pressure is too high, the fluid will be too
thick. If the pressure is too low, a continuous bead will have unexpected breaks in the
bead.

The three-backlit buttons on this unit provide a very convenient means for teaching a path. When
the top button is clicked, the robot is "freed" to permit it to be manually moved to any desired
position. For robots like the PrecisePlace that have direct drive motors on the X & Y axes and very
little friction, it is quick and easy to manually push the robot and accurately position the syringe tip in
free mode. When the robot has been properly positioned, clicking one of the two lower buttons
records either a node on a straight line or arc path. These three buttons provide a very intuitive and
rapid means for training even complex paths.

Table 4-1 describes the use of the buttons and the interpretation of the button lights during both path
teaching and normal execution.
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Backlit Button During Teaching During Process Execution

Red
(Free)

Click to "Free" or "UnFree" all axes of the
robot. Backlight is on when in Free mode.

In dispense simulation mode, backlight is
on when fluid should be dispensing.

Green
(Line)

Click to create and teach a Line node.
Backlight blinks momentarily to indicate node
created.

Backlight is on when a Line node being
executed.

Blue
(Arc)

Click to create and teach an Arc node.
Backlight blinks momentarily to indicate node
created.

Backlight is on when an Arc node being
executed.

Blue &
Green N/A Both backlights are on when executing a

Dot or Pause node.

Table 4-1: Button Lights

Dual Syringe Clamps

The Air Dispenser can control the air pressure for two syringes. Two syringes permit quick change
over when dispensing two types of fluids or when using two needle sizes. To accommodate two
syringes, two syringe clamps are provided. To avoid physical interference, one syringe clamp is
mounted in a fixed position on the robot's Z-axis, and the second clamp is mounted on a
pneumatically operated vertical slide so its tip can be positioned below the fixed syringe when in use
and moved up when not needed. Another feature of the Sliding Syringe Clamp is that it is equipped
with a sensor that can detect when the syringe needle touches the work surface.

Figure 4-3: Clamps
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As pictured in Figure 4-3, the vertical positions of both the Fixed and Sliding Syringe Clamps can be
adjusted by sliding them up or down within the Z-axis T-slots before being tightened down. Both
clamps have thumbscrews for retaining a syringe and can accommodate syringes up to 25 mm in
diameter. For smaller diameter syringes, a standard plastic insert can be obtained.

The Sliding Syringe Clamp has a total travel of 30 mm. When there is no air pressure, the clamp is
pulled into the down position by a spring. If the tip of the syringe mounted in this clamp touches a
surface, the clamp will rise up in the slide with a resistance generated by the spring. The Z-Contact
Sensor will detect this relative motion and this event will be captured by the robot's controller.
Typically, the Z-Contact Sensor is utilized for accurately setting the Z height at which to dispense a
fluid. This can compensate for manufacturing variations from part to part and can aid in ensuring
that the dispense process yields high quality results.

To ensure that the Sliding Syringe Clamp moves up and down quickly but without excessive impact,
a Bi-Directional Flow Control is mounted between the air supply line and the pneumatic actuator.
Two knobs are provided that control the air flow rate when the air pressure is applied or eliminated.

Arm-Mounted Camera and Light

If the system in use includes an arm-mounted camera and variable intensity light, Figure 4-4
illustrates how these units can be attached to the Z-axis of the PrecisePlace 2300 robot.

Figure 4-4: Camera on Z-axis of the PrecisePlace 2300

NOTE: Both the camera and the light mounting brackets can slide up and down in the
T-Slot of the Z-axis to permit these units to be positioned at the correct heights for an
optimal camera field-of-view.

In order to operate, the camera requires that an Ethernet and DC Power Cable be plugged into the
side opposite from the lens. The DC Power Cable furnishes 12VDC. The Ethernet cable is used to
receive commands from the PreciseVision software and to transmit back digitized camera images.
Typically a manually operated lens that provides an f-stop and focus ring is mounted to the camera.

28 Copyright © 2024, Brooks Automation



Brooks Automation 4. Hardware Introduction
Part Number: 608329 Rev. A PrecisePlace Robot Facilities End Cap

To avoid having these settings change during operation, the lens often has setscrews for fixing the
positions of the rings. These setscrews must be loosened in order to adjust either the f-stop or
focus. The Ethernet camera includes a Status LED on the same surface as the Ethernet connector.

LED State Camera Status

Off Camera is not receiving power.

Steady Red Camera is not initialized.

Slow Flashing Red Camera initialization problem. Most likely indicates a camera hardware failure.

Fast Flashing Red Camera is too hot.

Slow Flashing Blue Waiting for an IP address.

Fast Flashing Blue Ethernet cable is disconnected (no link).

Steady Blue IP address assigned, PreciseVision is not connected to camera.

Steady Green PreciseVision connected to camera, standard operational state

Slow Flashing Green Camera waiting for hardware trigger to take picture.

Fast Flashing Green Continuous acquisitions in progress, standard live video state

Table 4-2: LED Status

Since the light normally remains on at all times, it is not operated by the robot's controller. There is a
switch (labeled in Figure 4-4) that can be used to turn off the light, even when the controller is
powered on. In addition, there is a small knob by the on/off switch that controls the intensity of the
light. Normally, the light intensity should be set bright enough to overcome variations in the ambient
light but not so bright as to create a reflected glare back into the camera lens. For detailed
information on programming the machine vision system, see the PreciseVision Machine Vision
System, Introduction and Reference Manual.

PrecisePlace Robot Facilities End Cap

If the Guidance Dispense hardware components are mounted on a PrecisePlace Cartesian robot,
the robot's Facilities End Cap on the right side of the X-axis contains the plugs and connectors for
AC power, pneumatic air lines, Ethernet, and Digital IO signals.
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Figure 4-5: Robot End Cap

To provide air pressure to the Dual Control Air Dispenser, clean, dry external air should be
connected to the LEFT air fitting. This air line is routed through the interior of the robot and exits at
the Z-axis E-Chain where it plugs into the Air Dispenser.

             Air pressure

The maximum air pressure that can be conveyed by the air lines through the robot is
75 PSI. Applying a pressure exceeding this level may disconnect interior connections or
damage fittings or hoses. If a higher pressure is required, an external air line should be
utilized.

If the system in use is equipped with an arm-mounted camera, the camera communicates with
PreciseVision via Ethernet. The Ethernet cable that plugs into the camera is routed through the
interior of the robot and is connected to the robot controller's integrated Ethernet switch. The two
10/100 Mb Ethernet ports on the End-Cap are also connected to the same switch. Therefore, either
Ethernet plug can be used to interface to the camera and the robot's controller. The second
Ethernet port is provided as a wiring convenience.

If the system in use is equipped with a PreciseFlex Manual Control Pendant or an E-Stop box, these
units can be directly plugged into the "Front Panel / MCP / E-Stop" connector. The E-Stop button on
these units will be directly tied to the controller's hardware E-Stop inputs to ensure that the robot's
motor power can be quickly and reliably disabled.

The electric power required by the robot, its control electronics, the arm-mounted camera and its
light, and the Guidance Dispense hardware is all derived from the AC input line. The robot is
equipped with power supplies that can be utilized worldwide since they can accept voltages from 90
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to 132 VAC and 180 to 264 VAC, 50-60 Hz. Turning off the green backlit On/Off switch on the end-
cap will turn off power to the robot and all of the mounted hardware.

               Electrical Shock Hazard

The robot's controller and high voltage power supplies are located beneath the X-axis
cover. These units are all open frame electrical devices that have exposed unshielded
high voltage pins, components and surfaces. In addition, the motor power supply
provides 320VDC volts to the motors and takes about two minutes to bleed down after
power is disconnected. AC power to the robot must be disconnected prior to removal of
the X-axis cover for any reason.

To obtain detailed pin-out information for the Digital Input, Digital Output or Front Panel connectors,
see the PrecisePlace 2300/2400 Robot, Hardware Introduction and Reference Manual.
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5. Software Introduction

Guidance Dispense Software Overview

The Guidance Dispense product includes an open source application program with a web-based
graphical user interface. The purpose of this software package is to permit the user to teach and
execute a sequence of operations that will move a syringe tip along a taught path while
simultaneously sending commands to the dual control air dispenser to force out fluid as required.
This chapter introduces the software's principal concepts, terminology, and features. In additional,
each of the web pages and the function of their buttons and fields are described.

In Chapter 5: Step-By-Step Tutorials, this information is put to use in a series of step-by-step
tutorials that illustrate all of the basic operations of the system.

Within the Guidance Dispense software package, a complete dispensing operation is organized into
a dispensing Process that consists of one or more dispensing Paths that in turn consist of one or
more dispensing Nodes.

Figure 5-1: Dispensing Process

Using a simple web-based control panel, an operator can select and execute a taught dispensing
Process. A Process consists of a list of Paths that are performed in the sequence in which they are
defined within the Process. A Path defines a series of motions that control the position of a syringe
tip. The Path includes the specification for how fast the tool tip is to move when dispensing fluid and
how high above the start and end of the path the tool tip should be moved to start and end the
motion sequence.
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A Path can be automatically repeated with its positions offset in X, Y, and Z.  For example, a Path
can be automatically repeated at every position within an two dimensional array of parts.

Each syringe tip position within a Path is defined by a Node. A Node contains both the syringe tip
position as well as data specifying whether fluid should be dispensed while moving to this position.
A Path can contain thousands of Nodes if needed.

The names of Processes, Paths and Nodes can consists of 1 to 43 characters. Names must start
with an alphabetic character or "_" and cannot be a single "_." The first character can be followed by
any combination of alphanumeric characters (a-z,A-Z,0-9) and "_." Names cannot contain space
characters (" "). Upper and lower case letters are considered different, so names are case-sensitive.

When a Process is being executed, the data for the Process, its Paths and its Nodes are contained
in the robot controller's memory. To permanently retain this information, a copy of this data is stored
in files in the flash disk.  The Guidance Dispense application automatically loads the required data
files into the controller's memory when a Process or Path is accessed for editing or execution.

NOTE: To create and run a complete dispensing operation, the user must first teach a
series of Nodes to generate a Path. Then define the sequence in which the Paths are
to be performed by specifying their order within a Process. Finally, execute the
Process.

Dispensing Nodes, Node Types, and Reference Frames

A dispensing Node is the most fundamental data element within the Guidance Dispense software. It
defines a single syringe tip position and includes information about whether dispensing is turned on
or off relative to this position. In order to specify the robot motion or action associated with a
position, Nodes are organized into Node Types. For instance, there is a Node Type that indicates
that the syringe tip is to move along a straight line to the position and a different Type to specify that
a circular arc path is to be followed.

The following example illustrates a Path that contains four Nodes:

l Step 1:Moves the syringe tip to a starting location. When this location is reached, dispensing is turned
on.

l Step 2:Moves the tip along a straight-line path to a location that serves as the end of the line and the
start of an arc.

l Step 3:Moves the syringe along an arc path.

l Step 4: Turns off dispensing.

1. LineStrt -ON
2. LineEnd
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3. ArcMid
4. ArcEnd -OFF

While GD could have been designed to define Node positions with respect to the base of the robot,
instead, Node positions are always defined relative to a "reference frame." A reference frame
specifies an important XYZ position and orientation that is significant to the dispensing application.
For example, to dispense fluid on to a plate, the position and orientation of a corner of the plate
could be defined by a reference frame. Then, instead of teaching positions relative to the base of the
robot, each Node point would automatically be taught with respect to the corner of the plate. If the
plate were later re-positioned or re-oriented, the positions of all of the taught points could be
compensated by simply updating the position and orientation of the reference frame. This is
illustrated in Figure 5-2.

Figure 5-2: Node Paths

To simplify the use of a reference frame, by default, all Node positions are relative to the Global
Frame. A utility for quickly defining the position and orientation of this reference frame is included in
the GD software. If the value of the Global Frame is not taught, it will have a NULL value and all
Node positions will be with respect to the base of the robot.

If your system is equipped with PreciseVision, vision can dynamically compute and return a
reference frame that replaces all of the coordinates of the Global Frame except for its Z height. In
the example above, a camera could be used to locate the position and orientation of the corner of
the plate. Then all of the taught Node positions would be automatically adjusted to reflect the plate
position and orientation as determined by PreciseVision.

Since application requirements or fluid properties may require that dispensing be turned on at the
start of a motion or at the end of a motion or somewhere in between, GD supports a number of
means for specifying when dispensing signals should be turned on or off. Each Node can specify
that a signal must be changed a fixed distance or time from either end of its motion or as a
percentage of travel. By default, signals are changed at the end of each motion.

In Table 5-1, each of the Node Types are described. For some types, like the Line Node, simply
specify the need for a Line Node. However, when the Node is subsequently displayed, the software
automatically distinguishes whether a Line Node starts a sequence of straight-line motions, ends a
sequence, or is in the middle of a sequence. This extra qualification is provided as a visual aid in
understanding what motions are to be performed.
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Node
Type Description Graphic

Line

Line Nodes define points between which the syringe tip will be moved
along a straight-line path. A minimum of two Line Nodes are required
to defined a line path, the "LineStart" and the "LineEnd." In addition,
an arbitrary number of Line Nodes can be placed between these
points and will be labeled "LineMid."

A Line Node can be the first Node in a Path and can be used to start
an arc motion.

Arc

Arc Nodes define a circular arc motion. An arc motion must start with
a Line or Pause Node followed by an arbitrary number of pairs of Arc
Nodes. The minimum arc motion consists of a Line Node followed by
two Arc Nodes. Arc Nodes cannot be placed after a Path Break or
Dot. The last Arc Node in a sequence is labeled the "ArcEnd" and all
of the intermediate points are labeled "ArcMid."

The following rules apply:
l Arc Nodes must be defined in pairs.

l The first Arc Node must be proceeded by a Line or Pause
Node.

l Arc Nodes cannot be placed after a Path Break or Dot Node.

l Arc Nodes cannot be the first Node of a Path.

Path
Break

If you want to stop dispensing fluid and start another dispensing
sequence within a single Path, as a programming convenience, you
can insert a Path Break Node. This Node will turn off dispensing,
automatically move above the previous Node position by an amount
"mm Above Path," and then move to a position "mm Above Path"
above the next Node position.

The following rules apply:
l There must be a Node before and after a Path Break.

l Cannot be the first or last Node in a Path.

l Cannot be two of these Nodes in a row.

l Cannot be moved to since it has no robot position.

Pause

A Pause will stop the robot's motion at a Node for a specified period
of time. This is useful to form a fill area that is along the Path. This
Node can start or end a Path in order to delay before fluid is
dispensed or to delay until after the dispensing completes.

Table 5-1: Node Types
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Node
Type Description Graphic

Dot

A Dot Node dispenses a single dab of fluid at the Node position. The
dispense tip is moved above the Node position by the Path's
"Approach" height, moves down to the Node position and turns on
dispensing, delays for a specified time, turns off dispensing, and then
retracts to the Path's "Depart" height. This Node can start or end a
Path. In fact, a Path could consist of several Dot Nodes and nothing
else if required.

Dispensing Paths and Processes

A Path consists of a series of Nodes and can only operate a single syringe tip. A Path can contain as
few as one Node or can have thousands of Nodes to represent an extremely complex dispensing
pattern.

In addition to the list of Nodes, each Path includes specifications for the following functions and
parameters that can be uniquely defined for each Path:

l Z Height Search: At the first Node, GD can utilize the "Z-Contact" sensor or any similar device to detect
the actual height of the work surface. The difference between the expected and actual height will then be
automatically applied to correct the Z values of all Nodes in the Path.

l X, Y, Z Offset: The positions of all Nodes in the Path can be shifted by a fixed offset in all three
directions. This is useful for raising up the entire Path during debugging and for adjusting the Path height
following a Z-Search.

l 1D, 2D, 3D Pallets: A Path can be automatically repeated and indexed in 1, 2, or 3 dimensions. This is
convenient for repeating a pattern or for executing the pattern at each position in a 2D or 3D grid or
pallet.

l Approach and Depart Points: At the start of a Path, the syringe tip can be moved to a position above the
first Node before moving to the Node (the "Approach" point). Likewise, after moving to the final Node in a
Path, the syringe tip can be moved to a position above the final Node (the "Depart" point). This is a
convenient means for avoiding obstacles between dispensing patterns.

Figure 5-3: Approach and Depart Points

l Vision Process Reference Frame: At the start of the Path, a PreciseVision process can be executed and
the resulting position and orientation used in place of all but the Z height of the Global Frame to
dynamically compensate all of the Path's Node positions.
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l Dual Syringe Speeds: Different syringe tip speeds can be specified for when fluid is and is not being
dispensed to optimize the system cycle time.

Within a Path, there are some restrictions on when the various Node Types can be specified. The
following are the rules that apply to all Paths:

l First Node: The first Node must be a Line, Point, or Pause Type.

l Arc Nodes: Arc Nodes must always be specified in pairs and an arc path must start with a Line or
Pause Type.

l Final Node: The final Node cannot be a Break Path Type.

To permit a complete dispensing operation to be specified, multiple Path's can be combined into a
dispensing Process. A Process can be as simple as a single Path or can contain many different
Paths and even multiple references to the same Path. Paths are executed in the order in which they
are listed in a Process.

If your system includes two syringes and both syringes are utilized in the same operation, each
syringe must be controlled by one or more different Paths and these Paths must be specified in a
Process in the order in which they are to be executed.

To avoid driving the syringe into an obstacle as it moves to the Approach point for the first Path, a
Process always begins execution by retracting the robot to the Z height of a pre-defined Safe
Location and then moves horizontally to the Safe Location. Likewise, at the end of each Process,
GD retracts the robot to the Safe Location's Z height and then moves horizontally to the Safe
Location and terminates execution with the robot at this position.

Standard Web Page Format

The graphical user interface for the Guidance Dispense Application is composed of a series of web
pages. These web pages are stored on the robot controller's flash memory along with the
application software. They can be viewed either locally or remotely from a PC using Internet
Explorer. Since the web pages and the application software are stored in the controller, there is
never a problem of inconsistencies between the user interface and the application software.

When GD begins execution in its normal mode of operation, the first web page displayed will appear
as follows:
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Figure 5-4: Guidance Dispense Web Page Interface

The name of the software application, the top-level navigation bar, and a red Disable Power button
are displayed at the top of each web page.

                Disable Power

The Disable Power button is provided as a convenience for turning off power to the
robot’s motors. However, this should not be confused with a hardwired E-Stop button. A
hardwired E-Stop button directly connects to the controller hardware and guarantees that
the motor power will be quickly disabled. The Disable Power button relies upon the
proper operation of software to function.

The navigation bar allows the user to quickly switch between main web pages and access their
functions. In the case of the "Operator Control Panel" web page pictured in Figure 5-4, all of the
operations are available in a single panel. For other pages, a list of sub-pages is displayed in a table
on the left. Clicking on listed topics in the left table displays sub-panels that present additional
information.
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Table 5-2 briefly describes the contents of the pages associated with each of the tabs on the main
navigation bar. Each of these web pages and their sub-panels are described in greater detail later in
this chapter.

Main Navigation Bar Summary

Table 5-2: Main Navigation Bar Tabs

As an aid in learning how to use the Guidance Dispense application, a number of web pages and

panels contain a help hot spot marked by  . Click on this icon to access help information in a new
window.
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Enabling Motor Power and Homing the Robot

As a convenience, a number of the web pages provide buttons and fields for enabling/disabling
power to the robot's motors, displaying the current state of motor power, and for "homing" the robot.
For example, the Operator Control Panel has a "Robot Status" section that appears as follows:

Figure 5-5: Robot Status Section of the Interface

The Enable button enables power to the robot's motors and releases any motor brakes. The robot
will normally be left in a position control mode and the motors will maintain the current position of the
robot until a command to move is generated. The Disable button will immediately turn off power to
the motors.

               Electrical Shock Hazard

Before enabling power, ensure that the following steps have been performed: (1) the
robot has been properly mounted; (2) all required safety interlocks have been installed
and tested; and (3) power has been connected. For the PrecisePlace robots, this
information is provided in the “PrecisePlace 2300/2400 Robot, Hardware Introduction
and Reference Manual”.

When power is enabled, the System state transitions fromOff: switch on wait, which indicates
that the system is waiting for a switch to be changed to enable power, to one of the following:

l GPL Ready - Indicates that the robot is ready to operate in automatic mode.

l GPL Executing - Indicates that a dispensing operation is being run.

Several other informational messages are possible such as those that indicate that the robot is in
manual control mode or that a hardware E-Stop button is being asserted.

Some systems are also equipped with a blinking power light. In the case of the PrecisePlace robots,
a yellow LED is mounted on the top of the Z-axis motor. When the controller is first powered on, this
LED will blink at a rate of about once per second. When motor power is enabled, the LED will blink
at a rate of 4 times per second.
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Before the robot can execute a dispensing Process or move in certain manual control modes, the
robot must be "homed" in addition to having its motor power enabled. Homing is the process in
which each axis determines its position relative to an absolute 0 reference position. This permits the
robot to accurately repeat a taught motion sequence after AC power has been cycled and the
controller is restarted. Homing only needs to be performed once after the controller power is
restored, no matter how many times the motor power is enabled or disabled.

When motor power is enabled for the first time after the controller is restarted, click the Home
Robot button to home the robot. The homing method varies from robot-to-robot and from axis-to-
axis. Some axes are equipped with special homing sensors. Others simply rely upon a travel limit
signal or hard stop to re-establish the absolute position. In the case of the PrecisePlace robots, the
X and Y-axes are equipped with special PreciseFlex Pseudo Absolute Encoders that allow the
absolute position to be determined by making a very small 2-4 mmmotion. For most robots, the
homing process typically takes a minute or so to complete.

At the conclusion of the homing process, the Robot Homed field should indicate Yes and the robot
will be ready to be moved under manual or automatic control.

Operator Control Panel -- Main Web Page

TheOperator Control panel is used to select, start, stop, and control the execution of a dispensing
Process. It is normally the first web page that is displayed when this software package begins
execution. To access theOperator Control panel, select theOperator tab in the Navigation bar.
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Figure 5-6: Operator Control Panel

This panel is divided into three major sections:

1. SystemMessages

2. Robot Status

3. Select Process

System Messages

The SystemMessages section at the top of the panel contains a scrolling list of informational and
error messages that have been automatically generated. This section contains the following fields
and buttons:
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System Message Description

Message box

A read-only text box that displays all system and application messages. The most
recent message is displayed on the top line. See Chapter 5: Troubleshooting
Guide for a description of common error messages and output generated by
Guidance Dispense. See the PreciseFlex Library→Controller
Software→Software Reference→System Error Codes for a description of the
complete list of error messages that can be generated by the robot control
system.

Clear message
Clears all messages displayed in theMessage field This is convenient for
deleting old messages that can be confusing if attention is not paid to the
message time stamp.

Table 5-3: System Messages

Robot Status

The Robot Status field in the middle of the panel contains items for controlling motor power and
robot homing.

Robot Status Description

System State

See Enabling Motor Power and Homing the Robot for a description of these buttons and
fields.

Robot Homed

Enable

Disable

Home Robot

Table 5-4: Robot Status

Select Process

The Select Process field at the bottom of the panel permits the operator to select the dispensing
Process that they want to execute and to start and stop its execution.This panel also includes aids
for debugging and testing a Process.
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Select
Process Description

<Process
list>

Displays a list of Processes that are currently defined.  Before the "Start" button is clicked, a
Processmust be selected in this window.

Start Begins execution of the Process selected in the <Process List>. Before execution can commence,
robot motor power must be enabled and the robot must be homed.

Stop Immediately stops any process currently being executed. The dispense output control signals will
be turned off to prevent unintentional dispensing.

Purge
Displays a pop-up window that can move the robot to the designated "Purge" position and turn on
the specified dispense head(s). This is used to verify that the heads are working or to clear the
needles. See Purge Setup for additional information.

[ ] Disable
Outputs

If checked, disables the operation of the dispenser syringes when a Process is executed. The
dispenser output signal is re-directed to the Free teach button light on the Air Dispenser. This
mode is useful for test running an entire dispense Process without dispensing any fluid.

System
Speed

Reduces the speed of all robot motions to allow a Process to be run slowly for diagnostic and
debugging purposes. Normally, this speed should be set to 100% for normal operation.

Table 5-5: Select Process

Editing Web Page

The Edit Page

The Edit page provides a series of panels for creating, editing and managing dispensing Processes,
Paths, and Nodes. To open the Edit page, click the Edit tab in the Navigation bar.
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Figure 5-7: The Edit Page

When this page is first displayed, the right panel presents a brief summary of the relationship
between the dispensing elements and the steps for creating a complete operation. The three lists on
the left select the data to be edited and provide access to buttons for enabling motor power and
moving the robot.

The contents of the Editing list is as follows:

Editing Description

Process
Editor

Displays in the section to the right, the panel for creating, modifying and deleting dispensing
Processes. A detailed description of this panel is provided in the following section.

Path Editor Displays in the section to the right, the panel for creating, modifying and deleting dispensing Paths
and Nodes. A detailed description of this panel is provided in a following section.

Table 5-6: Editing

The Robot Status list contains a variation of the motor power control and homing items available in
the Operator Control Panel. In addition, it provides buttons for assisting in manually positioning the
robot.  This list and the following list are very useful for defining and touching up Paths and Node
positions.
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Robot
Status Description

<System
State>

See the section on Enabling Motor Power and Homing the Robot for a description of these buttons
and fields.

Homed

Enable

Disable

Home
Robot

Comp Places the robot back into computer control mode (to permit automatic execution) if the robot is
currently in manual control mode.

Free Places the robot into manual control mode and "free's" all of the axes.  Free'd axes can be
positioned by pushing the robot and manually moving it into position.

Stop
Immediate

Immediately decelerates and stops the robot if it is in motion and turns off all dispenser output
signals.  Then, the operator is prompted to determine if the robot should be retracted and moved to
the Safe Location.

Table 5-7: Robot Status

The Robot Move list provides a number of convenient means for repositioning the robot and purging
the syringes.

Robot
Move Description

Mini Jog Opens up a miniature version of the Virtual Manual Control Panel in a separate window. This panel
can remain open while jogging and teaching points in the editor.

Retract
Arm

If a Process is not executing, moves the robot in the world Z direction to the Z height of the Safe
Location. This is convenient for clearing an error or debugging an operation.

Move
Safe

If a Process is not executing, moves the robot in the world Z direction to the Z height of the Safe
Location followed by a horizontal motion to the Safe Location.

Run
Purge

Displays a pop-up window that can move the robot to the designated "Purge" position and turn on the
specified dispense head(s).  This is used to verify that the heads are working or to clear the needles.
See Purge Setup for additional information.

Table 5-8: Robot Move

Process Editor Sub-Panel

When the Edit tab is clicked and the Process Editor button is clicked, the panel pictured below is
displayed in the bottom right of the Edit page. This editor allows multiple dispense Paths to be
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organized into a Process. A Process can contain any combination of Paths and multiples
references to the same Path. Once a Process has been created, it will automatically be displayed
in the process list of the Operator Control Panel.

Figure 5-8: Process Editor

The "Process Files" list displays the names of the Processes that have already been created.  
Each Process is preserved in its own file on the flash disk. Guidance Dispense automatically loads
the data for a Process back into the controller's memory when it is required for editing or
execution. However, modified Process data is only stored to a disk file when an explicit command is
received to avoid replacing permanent settings with temporary trial data.

Process
Files Description

New Creates a new Process both in memory and on the flash disk. Once created, Processesmust have
Paths assigned to them.

Remove After confirmation, deletes the highlighted Process file from memory and the flash disk.

Run Executes the highlighted Process. This is the same operation performed by the Operator Control
Panel. *Note - this operation requires that the Process be saved prior to execution.

[ ] Disable
Dispense

If checked, disables the operation of the dispenser syringes when a Process is executed. This is
useful for running an entire dispense Process without dispensing any fluid.

Table 5-9: Process Files
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When a Process is selected in the "Process Files" list, the Paths assigned to the Process are
displayed in the "Process Contents" display. New Paths can be added to the selected Process
using the "Available Paths" list.

Process List &
Available
Paths

Description

Insert Inserts the Path highlighted in the "Available Paths" list into the Process above the
highlighted Path in the "Process Contents."

Append Appends the Path highlighted in the "Available Paths" to the end of the "Process Contents"
list.

Remove
Removes the Path highlighted in the "Process Contents" from the list. This does NOT
remove the Path file from memory or the flash disk, it just removes a reference to it in the
Process.

Save Saves any changes made to the currently selected Process to its flash disk file. Once saved,
you can use the "Run" operation or the Operator Control Panel to execute the Process.

Table 5-10: Processes & Paths

Path and Node Editor Sub-Panel

When the Edit tab is clicked and the Path Editor button is clicked, the panel pictured below is
displayed in the bottom right of the Edit page. The Path Editor provides the tools for creating,
managing and modifying Paths and their Nodes.
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Figure 5-9: Path Editor

The "Path Files" list displays the names of the Paths that have already been created. Each Path is
preserved in its own file on the flash disk. Guidance Dispense automatically loads the data for a
Path back into the controller's memory when it is required for editing or execution. However,
modified Path data is only stored to a disk file when an explicit command is received to avoid
replacing permanent settings with temporary trial data.

Path
Files Description

New

Creates a new Path both in memory and on the flash disk. Once created, Pathsmust have Nodes
added to them. This function displays a pop-up that prompts whether a new Path is simply to be
created (which is assigned a single Node) or whether a new Path should be created and a series of
Nodes taught. In teach mode, the user can create and define the position for Nodes by clicking a
pop-up button or using the teach buttons on the Air Dispense unit.

Remove After confirmation, deletes the highlighted Path file from memory and the flash disk.

Copy Makes a copy of the selected Path. The operator to enter a new Path name.

Verify

Performs a verification check on the selected Path. This test includes verifying that all of the Nodes
in the Path satisfy the rules and that the Z height of all Nodes is sufficiently high. This function is
provided to allow Paths to be pre-checked since this test is automatically performed when a Path is
executed.

Table 5-11: Path Files
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Path
Files Description

Run Path
Executes the highlighted Path. The operator is prompted to run the entire Path or one step at a
time. The step-by-step mode allows individual line/arc operations to be executed along the Path and
assists in debugging. In step-by-step mode, the dispenser output is automatically disabled.

[ ] Disable
Dispense

If checked, disables the operation of the dispenser syringes when a Path is executed. The dispenser
output signal is re-directed to the "Free" teach button light on the Air Dispenser. This is useful for dry
running a Path and fine-tuning Nodes while receiving visual feedback on the dispensing commands.

The "Global" section of this panel specifies parameters that affect the entire Path and are not
specific to a particular Node.

Global Description

Dispense Spd Specifies the speed (in mm/sec) of the syringe tip while it is dispensing fluid.

Trans Spd
Defines the transition speed (in mm/sec) of the syringe tip while it is moving between Nodes.
Anytime that fluid is not being dispensed, this speed is applied to optimize the overall cycle
time.

Approach/Depart Defines distance (in mm) that the dispensing head will moved above the first and last Node
positions when performing the dispensing Path.

Search

Enables the Z-Search mode. If "use probe" is selected, prior to performing the dispense path,
the robot will move to the first Node in the path and search down. When the surface is
detected, the "Z" height of the dispense Path is automatically adjusted (based on the "Z-
Search" settings). This operation is only performed once per path cycle.

Tool
Specifies the dispense head that will be used. This is important as it determines the digital
output that is operated to dispense fluid. In addition, the proper syringe dimension and
mounting offset is applied based on the definition of the Dispense Head.

Offset X, Y, Z
Defines a fixed offset that is applied to the position of each Node in the Path when the Path is
executed. It is also applied during teaching or editing of the Path points. This operation allows
fine tweaking of a Path without having to edit individual path points.

Table 5-12: Global

The "Pallet" section permits a Path to be repeated in a 1, 2 or 3 dimensional rectangular grid that is
relative to the Path's reference frame. This can be utilized to repeat a dispensing pattern at each
position in a pallet.
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Pallet Description

X, Y, Z
Idx (1-n)

Defines which dimensions will be repeated and how many times they will be repeated. By default these
values are all set to "1" to indicate that repeating is NOT enabled. If a Path is to be repeated on a
standard pallet, these values represent the number of rows (X), columns (Y) and stacks (Z) in the
pallet. In addition to setting these value, the "Pitch" must also be properly set.

X, Y, Z
Pitch
(mm)

Specifies the distance (in mm) between adjacent rows, columns or stacks.

Order Selects the order in which the 3 dimensions will be indexed. When a pallet is enabled (indicated by
having the 'Idx' values > 1) an order of operation is applied based on this setting.

Table 5-13: Pallet

The "Vision" section enables PreciseVision to dynamically compute a reference frame that replaces
all of the components of theGlobal Frame except for its Z height. When enabled, a user defined
PreciseVision Vision Process is automatically executed at the start of the Path. If PreciseVision
cannot locate the reference frame or if a visual part inspection indicates that a part is not
acceptable, Path execution will be terminated with an error.

Vision Description

[ ] Use Vision If checked, enables using PreciseVision to generate the Path's reference frame.

[ ] Index Camera

If checked, automatically indexes the position of an arm-mounted camera based on the
"Pallet" settings. This allows a grid of loosely fixtured parts to be addressed using a single
Path pattern. Each time the pallet is indexed, the arm-mounted camera will be positioned
to the next pallet location for the picture point and the vision system will be called again.

If not checked and a pallet is enabled, PreciseVision will only be called at the first pallet
location. All subsequent pallet Paths will use the original vision frame. This is useful for
fixed mounted cameras or parts that are fixed accurately in a tray but where the tray is
placed in the robot's work area in a coarse position.

Process Name Defines the required name of the PreciseVision Vision Process that is executed to
determine and return the Path reference frame.

Vision Tool Name

Optionally defines the name of a vision tool that is part of the PreciseVision Vision
Process. By default, the last tool executed by PreciseVision computes and returns the
value of the required reference frame. However, if a tool name is specified in this
parameter, its reference frame value is returned and utilized instead.

Picture Location
(X,Y,Z,yaw,pitch,roll)

Defines the position where the robot should be moved to prior to calling PreciseVision to
execute the Vision Process. If all of the components are set to "0" (the default), then the
picture point stored in the Vision Configuration is used instead. This picture point is taught
relative to theGlobal Frame. If this position is specified, its Z component is forced to
match that of the original camera calibration point defined in the Vision configuration.

Table 5-14: Vision
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Vision Description

Record (button)

Records the Picture Location where the robot must be moved to prior to executing the
Vision Process. This function automatically looks at the position stored in the Vision
Configuration and sets the new point to the same Z height. For arm-mounted cameras, it
is important that the Z height be constant to maintain the same field-of-view and scaling.

Perform (button)
Moves the robot to the Picture Location and performs the Vision Process. This assists in
debugging the Picture Location and Vision Process. This must be executed prior to
manually teaching Path points relative to the vision-generated frame of reference.

Move To (button) Moves the robot back to the Picture Location. This is useful for debugging the Vision
Process in PreciseVision.

The "Path Points" section displays and manages the list of Nodes defined in the currently selected
Path. Specific data for the Node selected in this list is displayed in the "Selected Path Point"
section.

Path Points Description

Path Point List View

Provides a scroll list of all the Nodes defined in the selected Path. This list also
displays any errors in the Path. If any error is detected, the list is displayed in Red. The
Node causing the problem includes a "*" prior to its name. Use the "Verify" operation to
get more descriptive details of the problem.

When the Node list display is generated, Node Types are automatically assigned
more descriptive names based upon the Node rules. For example, the first ARC Node
will be labeled "ArcMid" and the second will be labeled "ArcEnd."

Insert/Append/Remove
(buttons) Allows Nodes to be easily added and removed to/from the selected Path.

Advanced

Allows advanced Node add/remove operations. These include "Copying" and
"Removing" a range of Nodes and the ability to add more Nodes using the teach
buttons on the Air Dispenser. These operations make is very easy to duplicate a
section of a Path or remove unwanted areas of a complex Path.

Record (button) Records the current position of the robot relative to the current reference frame and
stores the value in the select Node.

Set Value

Simultaneously sets or increments a position component (X, Y, Z, Yaw, Pitch, Roll) for
a range of Nodes. This is very useful for adjusting all or part of a Path to have the same
"Z" value. Alternately, an offset can be added to a position component for a range of
Nodes.

Move To (button)

Moves the robot directly to the selected Node position taking into account the current
reference frame. If no special frame is in effect, theGlobal Frame will be utilized. If the
Path is relative to vision results, the position will be relative to the last generated Vision
Process reference frame.

*Note - care should be taken when clicking this button. If theGlobal Frame has been
re-taught improperly or Dispense Head dimensions or mounting have been changed, it
could lead to needle damage.

Table 5-15: Path Points
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Path Points Description

Extend/Retract (buttons) Extends or retracts the selected dispense head if it is equipped with a pneumatic slide.
These buttons provide a convenient way to operate the head digital I/O.

The "Selected Path Point" section displays the detailed information for the Node that is selected in
the "Path Points" list.

Selected Path
Point Description

X,Y,Z,yaw,pitch,roll

Displays the coordinates of the selected Node relative to the Path's reference frame.
These values represent the relative position and orientation of the Node with respect to
either theGlobal Frame or the frame generated by PreciseVision depending on the Path
settings.

Type Displays the Node Type for the current Path point.

Dispense
Selects if the dispense operation is turned on/off/nochange. Nochange will leave the
current state of the output for the dispenser unchanged. On/Off will turn on or off the output
of the dispense head.

Mode

For Line and Arc Nodes, specifies when the dispense operation change defined by the
"Dispense" parameter is put into effect.
l %Start/End - Change occurs at a percentage of the distance from the start or end of

the motion to the Node.

l mmStart/End - Change occurs at a distance in mm from the start or end of the motion
to the Node. "mm End" is the default setting and the most common case.

l Sec Start/End - Change occurs at a fixed time in seconds from the start or end of the
motion to the Node.

For Pause and Dot Nodes, this parameter is ignored.

For Path Break Nodes, this parameter indicates the "mm Above" height.

Value
Defines the decimal number that is the numerical portion of the "Mode" specification. For
example, if the Mode is "mm Start," this parameter defines the distance in mm from the
start of the motion to the Node when the dispense operation change takes place.

Save Path (button)
Saves the currently selected Path to the flash disk. The user can make changes to a Path
without saving. Once debugging is completed, use this button to permanently alter the
Path.

Table 5-16: Selected Path Points

NOTE: All changes to a Path will be lost if a different Path file is selected before the
changes are saved to the flash disk. Anytime a Path is modified a "Path modified" box
will be displayed next to the "Save Path" button to indicate the file on the flash is NOT
up to date.
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Configuration Web Page

Configuration -- Main Web Page

The Configuration page is displayed when the Configuration tab in the Navigation bar is clicked.
This page provides a number of utilities for defining system configuration and setup parameters. For
example, this page has a step-by-step process for defining theGlobal Frame and a panel for
configuring the digital IO signals that control the air dispenser and its teaching buttons.

Figure 5-10: The Configuration Page

When this page is first displayed, the right panel presents a brief summary of important setup
processes that should be executed. The three lists on the left select the configuration panel to be
display and provide convenient access to buttons for enabling motor power and moving the robot.

When a button in the "Configuration" list is clicked, the corresponding panel is displayed to the right.
In the following sections, the operation of each of these panels will be described in detail. The
following table contains a brief summary of these panels.
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Configuration Description

Robot Motion Defines the "Safe Location," robot speeds used during various motions and the minimum Z
height for all automatic motions.

Dispense Heads Defines the mounting position and dimensions of the two dispense heads (syringe tips) and
the digital IO signals that control their operation.

Global Frame Defines the reference frame that all Node locations are defined with respect to by default.

Purge Setup Defines the position to which the robot is moved to purge a syringe and the duration of the
purging operation.

Z-Search
Defines the parameters for searching for the Z height of a surface using the "Z-Contact
Sensor." The computed correction in the Z height will be applied to all Node locations in a
Path.

Teach Buttons Defines the digital IO signals assigned for the teach buttons on the Single/Dual Control Air
Dispenser.

Vision
Defines the interface parameters necessary for using PreciseVision with GD.  This includes
the vision PC's IP address and the location to which the robot is moved to take a picture
during the camera calibration process.

Guidance Web
Launches a new web window and displays the standard GUI for the PreciseFlex Guidance
Controller.  Access to this interface is provided for completeness and should not be required
during normal operation of the system.

Table 5-17: Configuration

The Robot Status list contains a variation of the motor power control and homing items available in
the Operator Control Panel. In addition, it provides buttons for assisting in manually positioning the
robot. This list and the following list are very useful for manually moving the robot to define key
locations necessary for the configuration operations.

Robot
Status Description

<System
State>

See the section on Enabling Motor Power and Homing the Robot for a description of these buttons
and fields.

Homed

Enable

Disable

Home
Robot

Comp Places the robot back into computer control mode (to permit automatic execution) if the robot is
currently in manual control mode.

Table 5-18: Robot Status
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Robot
Status Description

Free Places the robot into manual control mode and "free's" all of the axes.  Free'd axes can be
positioned by grabbing the robot and manually moving them into position.

Stop
Immediate

Immediately decelerates and stops the robot if it is in motion and turns off all dispenser output
signals.  Then, the operator is prompted to determine if the robot should be retracted and moved to
the Safe Location.

The Robot Move list provides a number of convenient means for repositioning the robot and purging
the syringes.

Robot
Move Description

Mini Jog Opens up a miniature version of the Virtual Manual Control Panel in a separate window. This panel
can remain open while jogging and teaching points in the editor.

Retract
Arm

If a Process is not executing, moves the robot in the world Z direction to the Z height of the Safe
Location. This is convenient for clearing an error or debugging an operation.

Move
Safe

If a Process is not executing, moves the robot in the world Z direction to the Z height of the Safe
Location followed by a horizontal motion to the Safe Location.

Run
Purge

Displays a pop-up window that can move the robot to the designated "Purge" position and turn on the
specified dispense head(s). This is used to verify that the heads are working or to clear the needles.
See Purge Setup for additional information.

Table 5-19: Robot Move
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Robot Motion and Safe Location Sub-Panel

When the Configuration tab is clicked and the Robot Motion button is clicked,, the panel pictured
below is displayed in the bottom right of the Configuration page.  This panel defines the "Safe
Location," robot speeds used by various motions and the minimum Z height for all automatic
motions.

Figure 5-11: Safe Location Sub-Panel

The Safe Location is a position where the robot can be moved to be clear of all obstacles in the work
cell. When a Process begins execution, the robot is always moved to the Safe Location before
going to the first Node.  After the motion to the last Node, the robot is returned to the Safe Location
before the Process terminates.

Motions to the Safe Location are always performed in two steps:

l Retracts the robot to the Z height specified by the Safe Location.

l Moves horizontally to the Safe Location.

NOTE: The Z height of the Safe Location is particularly important since the robot
moves to the Safe Location by first retracting to this Z height and then moving
horizontally to the Safe Location.  Also, other operations, like Purging, also use this Z
height for moving safely through the workspace.
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Safe
Location Description

Teach Safe Point Records the current location of the robot as the value of the Safe Location.

Move Safe Point Moves the robot to the safe point.  This is convenient for placing the robot into a known
location.

Table 5-20: Safe Location

The "General Motions Settings" contains speed and acceleration specifications that apply when the
system is moved automatically during training (e.g. Purge and Move Safe operations) and when the
robot is moving between Paths. While executing a Path, the transit and dispensing syringe tip
speeds are explicitly specified as parameters to the Path.

General
Motion
Settings

Description

Run Speed (%
max)

Defines the speed (as a percentage of the robot's maximum nominal speed) of motions when
executing a Process but not following a Path.

Edit Speed (%
max)

Defines the speed (as a percentage of the robot's maximum nominal speed) for automatic
motions performed during training and debugging, e.g. Purge motions and moving to the Safe
Location.

Accel/Decel
(% max)

Defines the acceleration and deceleration (as a percentage of the robot's maximum nominal
values) for all motions except when following a Path.

Accel Ramp
(seconds)

Defines the acceleration/deceleration ramp times (s-curve profiling) for all motions except when
following a Path.

Table 5-21: General Motion Settings

Whenever the robot is moved automatically both during training and when executing a Process, the
destination of each motion is tested to ensure that it is not too low relative to the Z height of the
Global Frame.  This is a precaution to prevent a syringe tip from being inadvertently driven into the
deck.

Path
Verify
Test

Description

Z path
node test

Defines the minimum Z height relative to theGlobal Frame for the destination of all automatic motions. 
Any motion that attempts to go below this value will be terminated and flagged as an error.  To disable
this test, a large negative values should be entered.

Table 5-22: Path Verify Test
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Path
Verify
Test

Description

Save Updates the motion settings saved on the flash disk.

Safety Zones

For all robot types, “Safety Zones” can be defined that disable motor power and halt the motion of
the robot if its tool center point (TCP) violates the requirements of a user defined 3D volume.

Types of Safety Zones

These 3D safety zones can be used to:

1. Approximately model the volume of stationary objects or personnel working areas to prevent the

robot from inadvertently entering this volume and causing a collision (“keep out zones”).

2. Reduce the normal working volume of the robot to prevent the robot from reaching beyond prescribed

boundaries and causing a collision (“stay within zones”).

3. Verify that the robot’s TCP speed (when in a specified volume) is below a specified limit so that the

robot can be safely decelerated and stopped before it might pin an operator’s hand to a hard surface

with too high a force (“speed restrict zones”).

As currently implemented, the “keep out zones” and “stay within zones” are provided as general
safety features, but they do not meet the stringent Category 3 safety standards that require fail safe
redundant logic. However, the “speed restrict zones” do provide the requisite redundancy and are in
the process of being Category 3 certified. The “keep out zones” and “stay within zones” are
collectively referred to as “uncertified zones” and the “speed restrict zones” are referred to as
“certified zones”.

The supported zone shapes are rectangular volumes, cylinders and spheres. To define a safety
zone, the type of safety zone must be specified along with its origin and dimensions.
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Figure 5-12: Rectangular Volume

Figure 5-13: Cylinder

Figure 5-14: Sphere
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For increased generality, uncertified zones can be arbitrarily positioned and rotated in all three
dimensions. Due to implementation limitations, certified zones must be non-rotated rectangular
volumes, which can be arbitrarily positioned. Up to 10 zones can be defined for each robot and any
mix of certified and uncertified can be specified. Due to safety requirements, any new or modified
zone specifications only go into effect after the controller is rebooted.

Safety Zone Violation Detection and Clearing

Uncertified safety zones are active in the following circumstances:

l Continuously during program-controlled motions of all types (straight line or arc Cartesian and joint
interpolated).

l Continuously during manual (jog) control modes: World, Tool and Joint, but not free.

l Motion planning (final destinations only).

l Location object.KineSol method during conversions to either Cartesian or joint Locations.

Certified safety zones are only active during program-controlled motions (of all types) since this is
the only circumstance where higher TCP speeds are possible.

When motor power is enabled and the robot’s TCP is in violation of an uncertified safety zone, a
program-controlled motion cannot be initiated. This condition can be cleared by disabling motor
power and manually repositioning the robot or by manually jogging the TCP in World, Tool or Joint
modes, so long as the jog motion reduces the safety zone violation distance. That is, jogging
motions that increase the violation of a safety zone are not permitted.

NOTE: Safety zone testing is based on the TCP of the robot. Therefore, it is very
important that the position of the tool center point relative to the robot’s tool mounting
flange is set correctly. Please see the Robot.Tool property for information on defining
the TCP.

Certified Speed Restrict Safety Zones

While the uncertified safety zones perform conventional tests on just the position of the TCP, there
are two certified safety zones and these perform special tests to detect if the speed of the TCP
exceeds a limit while the TCP is within the zone. The first certified safety zone tests if the Z
downward speed of the TCP exceeds a specified limit. This safety zone was implemented for the
PreciseFlex 400 and PreciseFlex 3400 robots since their only intrinsically non-safe motion is a high-
speed downward Z motion that could trap a person's hand between the tooltip and a fixed object or
horizontal surface. The second certified safety zone tests if the horizontal, XY planar, speed of the
TCP exceeds a specified limit. This test was developed for the PreciseFlex™ DD robots since
robots can generate excessive speeds when moving horizontally.

For both of these tests, in order to satisfy the computational redundancy requirement of the
Category 3 safety regulations, the shapes of these safety zones are limited to non-rotated
rectangular volumes.
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Please consult the user manuals for these PreciseFlex™ robots for when speed restrict safety
zones must be defined to safely operate these mechanisms.

Configuring Safe Zones

Up to 10 safety zones can be defined per robot. Each of these zones is specified by filling in one of
the Parameter Database IDs 16900 to 16909, which are labeled "Safety Zone: type, x/y/z/y/p/r, dim
1/2/3". Any combination of certified and uncertified safety zones can be specified. Each of these
DataIDs consists of an array of 10 numbers and the first value defines the safety zone “type”. Any
DataID that has a zero “type” is ignored. Table 5-23 describes the possible safety zone types:

Safety Zone Type Description

0. Undefined safety zone

1. Rectangular volume, keep out zone

2. Cylinder, keep out zone

3. Sphere, keep out zone

4. Rectangular volume, stay within zone

5. Cylinder, stay within zone

6. Sphere, stay within zone

7. Non-rotated rectangular volume, Z downward speed restrict zone

8. Non-rotated rectangular volume, XY speed restrict zone

Table 5-23: Safety Zone Types

Table 5-24 describes the safety zone DataIDs. When any of these DataIDs are modified, the
controller must be rebooted for the change to be put in effect.
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DataID Parameter
Name Description

16900 to 16909 Safety Zone: type,
x/y/z/y/p/r, dim 1/2/3

Each safety zone definition consists of an array of 10 values.
The first value is the safety zone “type”. The next six values
define the position of the origin of the volume of interest and its
orientation. This is specified as a standard Location value:

x, y, z, yaw, pitch, roll.

The final three values define the size of the volume of interest.
For the permitted shapes, this is interpreted as:

volume:   Dx, Dy, Dz
Cylinder:   Dh, Dr, 0
Sphere:   Dr, 0, 0

For example, for a downward Z non-rotated rectangular volume
speed restrict safety zone, a single DataID should be specified
as follows:

7, x, y, z, 0, 0, 0, Dx, Dy, Dz

Where x, y, z are the coordinates of the center of the base of the
rectangular volume and Dx, Dy, Dz are the dimensions of the
volume, all in mm.

Table 5-24: Data IDs

In addition, the DataID in Table 5-25 must be initialized to establish the maximum speed limits for
the certified safety zones:

DataID Parameter
Name Description

2740 Certified safety zone,
max Z/XY spd mm/sec

These parameters define the maximum speeds that are
permitted for the Certified Speed Restrict Safety Zones. The
first value is the maximum downward Z speed (when within
the safety zone) in mm/sec. Since this is a downward speed,
it should be a negative value and defaults to -200. The
second value is the maximum permitted speed in the
horizontal XY plane (when within the safety zone), and
defaults to 200 mm/sec.

Table 5-25: Data IDs
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Dispense Heads Sub-Panel

When the Configuration tab is clicked and the Dispense Heads button is clicked, the panel
pictured below is displayed in the bottom right of the Configuration page.  This panel defines the
mounting position and dimensions of  the two dispense heads (syringe tips) and the digital IO
signals that control their operation.

Figure 5-15: Dispense Heads Sub-Panel

It is permissible to teach a Path and repeat the Path without knowing the dimensions or mounting
position of the syringe heads.  But, if GD does know this information, if a syringe and needle size
changes or if a syringe needle bends, GD can automatically adjust the robot motions so that the
new syringe tip will follow the previously taught Path.  In addition, if two syringes are used, the
Nodes taught with one syringe can be easily repeated by the other syringe.

To simplify the training of the dimensions and mounting of the syringe tips, you must select a
"Reference Point" in the work cell that does not move.  Then, to teach the dimensions and mounting
of a different syringe tip, you only need to move that tip to the same Reference Point and click a
button.  GD will compute the required information and will automatically put this data into effect each
time the syringe tip is selected.

NOTE: Once the Reference Point value is taught, it should not be changed. If this
value is re-taught with a syringe tip that is a different size or is mounted in a different
position on the robot, it will alter the result of any syringe tips that are taught with
respect to this new Reference Point and any formerly taught Paths will be incorrect.
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Reference Description

Rec Reference Records the value of the Reference Point. Dispense head #1 must be used to teach this
location.

X, Y, Z, Yaw, Pitch,
Roll

Displays the coordinate values of Reference Point.  These should not be altered once they
are taught.

Move To Displays a pop-up window that can move a syringe tip to the Reference Point or to a position
above this location.

Table 5-26: Reference Point

Once the Reference Point is established, the dimensions and mounting of either dispense head can
be taught or re-taught simply by moving the desired syringe tip to the Reference Point and pressing
the Rec Offset button.  The following data pertains to each of the dispense heads.

Head 1 or 2 Description

Rec Offset Computes the dimension and mounting data for a dispense head when the syringe tip is
positioned at the Reference Point.

X, Y, Z, Yaw,
Pitch, Roll

Displays the computed coordinate values for the dispense head.  Initially, the values for head
#1 will all be close to 0.

Move To Displays a pop-up window that can move a syringe tip to the Reference Point or to a position
above this location.

Extend Signal Defines the number of the Digital I/O signal that controls the extension and retraction of the
sliding syringe clamp.  When this signal is asserted, the slide is extended.

Dispense Signal Defines the number of the Digital I/O signal that applies air pressure to the syringe. When this
signal is asserted, fluid is dispensed.

Extend/Retract Turns the Digital I/O signal that controls the syringe slide off or on. This allows for debugging
the dispense head locally on this page.

On/Off Actuates the dispense signal.  This operation allows for debugging the dispense fluid.

Save Saves all dispense head information to the flash disk.

Table 5-27: Dispense Heads
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Global Frame Sub-Panel

When the Configuration tab is clicked and theGlobal Frame button is clicked, the panel pictured
below is displayed in the bottom right of the Configuration page.  This panel specifies the reference
frame that all Node locations are defined "with respect to" by default.

Figure 5-16: Global Frame Sub-Panel

Node locations are always defined with respect to a reference frame.  If vision is being used, the
vision results dynamically supersede all of the coordinates of theGlobal Frame except for its Z
height..  If no special reference frame is in effect, Node locations are automatically defined relative
to the completeGlobal Frame. 

NOTE: TheGlobal Frame should be defined as soon possible to ensure that all
Node locations are correctly recorded.

This panel displays the current value of theGlobal Frame.  This value is automatically computed
from the X, Y, Z coordinates of three locations that point at the following features of the reference
frame:

l The origin (0,0,0) of the reference frame.

l Any position along the X-axis of the reference frame.

l Any position that is in the X-Y plane of the reference frame and generally along the Y-axis.
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NOTE: As soon as the X, Y or Z coordinate of any of the three locations is altered,
theGlobal Frame is immediately recomputed and the new value will be reflected in
the location of all Nodes that are relative to this reference frame.

Global
Frame Description

Teach
Frame
Wizard

Launches the step-by-step wizard for teaching the three locations that define theGlobal Frame.  As a
convenience, the "Line" and "Free" buttons on the Air Dispenser can be used in place of the wizard's
"Record" button and the Virtual Manual Control Pendant.  At the end of this operation, the new frame
value is automatically saved to the flash disk.

Teach
Origin

Displays a pop-up that permits one of the three locations to be set equal to the current location of one
of the syringe tips.

Teach
POX

Teach
POY

X, Y, Z,
Yaw,
Pitch, Roll

Displays the three sets of location coordinates and permits them to be edited.

Move To Displays a pop-up window that can move the robot to the associated location or to a position above
this location.

Save Saves the frame value to the flash disk.

Table 5-28: Global Frame Descriptions

Purge Setup Sub-Panel

When the Configuration tab is clicked and the Purge Setup button is clicked, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel defines where the robot
is moved to purge the two dispense heads and the duration of the purge operation.
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Figure 5-17: Purge Setup Sub-Panel

The purge operation is a pre-defined process that safely moves the robot to a designated position
and dispenses fluids for a specified period of time. This function can be manually invoked from a
number of pages and is used to test if a syringe is operating properly and to clear the needle.  The
purge operation performs the following steps:

l Retracts the robot to the Z height specified by the Safe Location.

l Moves to the "Approach" position that is the specified number of mm above the purge position.

l Moves to the purge position with the syringe slide in the retracted position.

l Turns on the syringe air supply for the specified number of seconds.

l Retracts the robot to the Z height specified by the Safe Location.

l Moves horizontally to the Safe Location.

For this function, the speed and acceleration of the robot is defined by the Robot Motion
parameters. For each syringe head, the following fields and buttons are defined.

Purge
Parameters Description

Run Purge Executes the purge operation as defined above.  This is the same function that is available on
a number of other panels.

Rec Head # Records the current position of the robot (with no tool enabled) for the selected dispenser
head.

X, Y, Z, Yaw,
Pitch, Roll Displays the purge location coordinates and permits them to be edited.

Move To Displays a pop-up window that can move the robot to the purge position or to a position above
this location.

Table 5-29: Purge Parameters
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Purge
Parameters Description

Time Specifies the duration that the syringe is purged in seconds.

Approach Defines the "Approach" height above the purge location.

Save Saves the purge settings to the flash disk.

Copyright © 2024, Brooks Automation 69



5. Software Introduction Guidance Dispense System
Configuration Web Page Part Number: 608329 Rev. A

Z-Search Sub-Panel

When the Configuration tab is clicked and the Z-Search button is clicked, the panel pictured below
is displayed in the bottom right of the Configuration page. This panel defines the parameters for
searching for the Z height of a surface using the "Z-Contact Sensor."

Figure 5-18: Z-Search Sub-Panel

The Z-Search is an option that can be selected for any Path. When enabled, at the start of the Path,
GD samples the Z-Contact Sensor to locate the height of the work surface at the first Node position. 
The correction between the actual height and the Z height of the first Node is dynamically applied to
all Nodes in the Path.

If a Path has Z-Search enable, at the start of the Path, the syringe tip will be controlled as follows:

l Moves to the "Approach" position above the first Node.

l Moves down in Z at the "Search speed" and "Search accel" traveling a maximum "Search distance."

l Monitors the "Probe digital signal" and stops when the signal becomes TRUE.

l Retracts the syringe at 25% of the "Search speed" until the "Probe digital signal" is FALSE.  This permits
a faster "Search speed" while still obtaining an accurate height reading.

l Computes the difference between the first Node's Z position and the detected Z position minus the
"Backout gap distance."

l Moves to the first Node position and all subsequent Nodes in the Path applying the Z correction and the
X/Y/Z offset defined in the Path Editing Page to all Nodes.

Normally, the Z offset specified in the Path Editing Page is utilized to move the entire Path up to the
proper height above the work surface to correctly dispense the fluid.
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Z-Search
Settings Description

Probe digital
signal

Defines the Digital I/O signal number for the contact probe. This signal becomes TRUE when the
surface is detected.  This defaults to 10039, which is the DIN signal normally connected to the Z-
Contact Sensor.

Search
speed (%
max)

Defines the speed (as a percentage of the robot's maximum nominal speed) for the search motion.

Search
accel (%
max)

Defines the acceleration (as a percentage of the robot's maximum nominal acceleration) to be used
during the search motion.

Search
distance
(mm)

Defines the maximum distance in mm that the robot is permitted to move during the search. If this
distance is exceeded, the search will fail and will generate an error.

Backout gap Defines the distance in mm between where the slide is fully extended and where the slide is
retracted sufficiently to trigger the contact sensor.

Save Saves the settings to the flash disk.

Table 5-30: Z-Search Settings

Teach Buttons Sub-Panel

When the Configuration tab is clicked and the Teach Buttons button is clicked, the panel pictured
below is displayed in the bottom right of the Configuration page. This panel defines the system
digital input and output signals that return the state of the three buttons on the PreciseFlex
Single/Dual Control Air Dispenser and control their backlights. These settings should not have to be
changed once a system is wired and the hardware configuration has been debugged.

Figure 5-19: Teach Buttons Sub-Panel
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If you are using a PreciseFlex Air Dispenser mounted on a PrecisePlace robot, the DIO signals
should be set as shown in the picture above. These are signals that are provided by the robot's ZIO
board that is mounted next to the Z-axis motor. If you do not have a PreciseFlex Air Dispenser you
can configure these signals to connect to your own button box. These buttons and lights are a
programming convenience and are not needed for the proper operation of the GD application
program. If any of these signals are not present, their signal number should be set to 0 to avoid
generating a runtime error.

Teach
Buttons Description

Line
Input/Output

Defines the DIO signals that are TRUE when the green create "Line" Node button is clicked
during teaching and that is set TRUE to turn on this buttons backlight.

Arc
Input/Output

Defines the DIO signals that are TRUE when the blue create "Arc" Node button is clicked
during teaching and that is set TRUE to turn on this buttons backlight.

Toggle Free
Mode
Input/Output

Defines the DIO signals that are TRUE when the red Free button is clicked to place all of the
axes into manual control "Free" mode and that is set TRUE to turn on this buttons backlight.

Save Saves the DIO signal assignments to the flash disk.

Table 5-31: Teach Buttons

Vision Sub-Panel

When the Configuration tab is clicked and the Vision button is clicked, the panel pictured below is
displayed in the bottom right of the Configuration page. This panel defines the interface parameters
necessary for using PreciseVision with GD.

Figure 5-20: Vision Sub-Panel
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Guidance Dispense contains built-in support for communicating with a PC that is executing
PreciseVision. When GD requires vision to compute a frame of reference, it sends PreciseVision a
command over Ethernet to execute a vision process. Typically, the vision process will consist of an
Acquisition tool (for taking a picture) and just a few tools for determining the position and orientation
of the object of interest. The results of the final tool are automatically returned to GD and
dynamically replace all of the components of theGlobal Frame with the exception of its Z height.

In order for GD to communicate with PreciseVision, it requires the Ethernet IP address of the PC.

IP
Address
of Vision
Server

Description

IP Address
of vision
server

Specifies the IP address of the PC executing PreciseVision. This address is used by GD to issue
commands to PreciseVision and retrieve data. This address can normally be found on the PC by
viewingMy Network Places → Network Connections→ Local Area Connection → Status. By
default, this is assumed to be 192.168.0.100.  If you have executed the software installation
procedure for PreciseVision, this value will already be properly set.

Vision Test
Process
Name

Defines the name of a PreciseVision process that can be executed to test that the communication
connection is correct.  Typically, you should create a test process that just consists of an Acquisition
tool and a Fixed Frame tool positioned anywhere in the window.  The value of this parameter is
NOT SAVED to the flash disk.

Test Vision

When clicked, sends a message to PreciseVision to execute the "Vision Test Process." If the
communication channel is operating, the PreciseVision display will show that the process has been
executed and GD will display the X & Y position of the vision result (normally the position of the
Fixed Frame).  If the IP address is incorrect, GD might hang for 1-2 minutes before the system
times out.

Table 5-32: IP Address of Vision Server

The following radio buttons select how the camera is mounted. Fix mounting the camera above the
robot is advantageous if a large field of view is desired and you want to take pictures when the robot
is out of the work area. An arm-mounted camera is preferred if you require higher resolution since a
smaller field of view can be used but you can still cover a large area by having the robot move the
camera around the workspace.

Select
Camera
Mount

Description

Fix Mounted Indicates that the camera is mounted in a fix location above the work surface of the robot. The
camera does not move.

Arm Mounted Indicates that the camera is mounted to the Z-axis of the robot. The camera must be moved
back to the original picture position during camera calibration.

Table 5-33: Camera Mount
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In order for PreciseVision to return position coordinates and orientation angles that can be used by
the robot, the relationship been where the camera is looking (i.e. its field of view) and the
coordinates of the robot must be determined. This relationship is computed by performing a "Robot
Vision Area Calibration." The following parameters are used for this procedure.

NOTE: For arm-mounted cameras, if the position defined in the following data is
altered after the calibration is completed, the calibration will be invalid and must be
computed again.

Camera
Calibration

Point
Description

Teach Point Records the current robot position as the position that the robot will be moved to when a picture
is taken during the calibration process.

X, Y, Z, Yaw,
Pitch, Roll

Defines the position that the robot will be moved to when a picture is to be taken during the
calibration process.  For a fixed mounted camera, this position should move the robot out of the
way so it does not block the camera field of view.  For an arm-mounted camera, this should
position the camera over the calibration target and at the proper Z height to produce the correct
size for the field of view.  This position should be defined before performing the calibration
procedure and only altered if you want to re-execute this procedure.

Move To Displays a pop-up window that can move the robot to the picture taking position or to a position
above this location.

Calibration
Setup

Opens a small dialog that assists in performing the calibration procedure. This window should
be kept on the desktop while performing the procedure. During an arm mounted camera
calibration, this dialog is used to move the camera back to the picture taking position.

Save Saves the vision settings to the flash disk.

Table 5-34: Camera Calibration

Virtual Pendant -- Main Web Page

The Virtual Manual Control Pendant (VMCP) page is displayed in its own browser window when the
Virtual Pendant tab in the Navigation bar is clicked. The VMCP provides the same functionality
available from a hardware Manual Control Pendant, i.e. the ability to manually move the robot in
various modes and display the current robot position.
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Figure 5-21: Virtual Manual Control Pendant

The "Positions" section at the top of the panel displays the location of the currently selected syringe
tip and the position of each of the robot's axes.

Position
Display Description

X, Y, Z, Yaw,
Pitch, Roll

Displays the position and orientation of the currently selected syringe tip in Cartesian
coordinates. The X, Y and Z are in millimeters. The three angles are in degrees and are a set of
Euler angles. These angles correspond to a Yaw rotation about world Z-axis (rotating to the left and
right along the horizon), followed by a Pitch rotation about the new Y-axis (tilting to look up into the
sky or down into the ground), followed by a Roll rotation about the new Z-axis (rotating to the left
and right about the new vertical axis).

Jt 1/7 ... Jt
6/12

Displays the current position of each of the axes of the robot in millimeters or degrees as
appropriate.

Table 5-35: Position Display

The "Robot Status" section in the middle of the panel contains items for controlling motor power and
robot homing.
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Robot
Status Description

System State

See the section on Enabling Motor Power and Homing the Robot for a description of these
buttons and fields.

Robot Homed

Enable

Disable

Home Robot

Table 5-36: Robot Status

The "Jog Control" section at the bottom of the panel is used to move the robot in various manual
control modes. Prior to jogging the robot, motor power must be enabled and the robot must be
"homed."

To move, you first select a mode, then an axis or coordinate, then a speed and finally press the "+"
or "-" key to move the axis in the positive or negative direction.  Releasing the "+" or "-" key or
changing modes terminates the motion.

Jog Control Description

Disables Jog Control and permits GD to take control of the robot and automatically move its
axes. This mode should always be selected when you have finished moving the robot in jog
mode.

Moves all of the axes of the robot in a coordinated fashion such that the selected syringe tip
travels in a straight-line path along or rotates about the X, Y, or Z axes of the robot’s world
reference frame.

Similar to World mode except that the reference frame is determined by the selected syringe's
orientation. For example, since the Z-axis of the syringe normally points down, a positive motion
in tool Z will move the syringe down.

Moves individual axes one at a time. Even if an axis is beyond its limit stops, this mode can be
used to drive the axis back into the working range.

Allows one or more axes to be taken out of position control mode to permit the axis to move
freely. For lightweight robots, this allows the operator to grip an axis and manually repositioned
it.

<Select
Axis/Joint>

Displays the axes that can be moved for the active jog control mode. An axis must be clicked in
order to select it to be moved.

Jog Speed %

Specifies the speed that the axis will move, specified as a percentage of the maximummanual
control speed. The speed can be entered numerically, incrementally changed with the speed "+"
and "-" keys or by clicking one of the numbered speed keys. The "Inc" keys move the axis by a
small step and then stop rather than moving continuously. This is convenient for making fine
position adjustments.

Table 5-37: Jog Control
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Jog Control Description

Jog Axis ("+", "-
")

Moves the selected axis in the positive or negative direction at the selected speed. For Free
mode, multiple axes can be simultaneously free'd by selecting the axis number and pressing the
"+" key.  Pressing the "-" key or selecting a different jog mode un-frees an axis.

Help -- Main Web Page

The Help Panel is displayed when the Help tab in the Navigation bar is clicked.  This page provides
links to abbreviated online versions of much of the help information that is available in this chapter
plus the tutorial examples.

Figure 5-22: Help
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6. Step-By-Step Tutorials

Tutorials Introduction

This chapter contains a series of Step-By-Step Tutorials for the Guidance Dispense software
application. These tutorials are intended to introduce all of the basic operations required to setup
the system and develop simplified typical applications.

These tutorials are organized into two groups: 

l Setup Tutorials. These introduce all of the steps necessary to operate the system and initialize
parameters that define the dispensing tools and workspace. These tutorials should always be executed
in the order they are presented since they initialize data that is inter-dependent. In general, these
tutorials only have to be executed once until the tooling or some element of the work cell is modified.

l Application Tutorials. The first tutorial is a complete, basic example. This is followed by a series of
modifications of the basic example. These variations can be executed in any order.

Before performing these tutorials, ensure that the following has already been completed.

l A PC has been interfaced to the robot and a web browser can display the graphical user interface of the
robot controller. If this has not been completed, see the Setup and Installation chapter of this manual.

l The Guidance Dispense software has been installed on the controller and has been started. This
information can also be found in Setup and Installation.

l You have reviewed the Hardware and Software Introduction chapters of this manual. A thorough
understanding of the content of these sections is not required since much of what you read will become
clearer as you perform the tutorials. However, a understanding of the basic operation of the hardware
and the concepts and nomenclature of the software will be very helpful.

Before operating your robot, ensure that the following steps have been performed: (1) the
robot has been properly mounted; (2) all required safety interlocks have been installed
and tested; and (3) power has been connected. For the PrecisePlace robots, this
information is provided in the “PrecisePlace 2300/2400 Robot, Hardware Introduction
and Reference Manual”.
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Begin with the Setup Tutorials and execute them in order.
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Setup Tutorial 1: Enabling Power and Homing

The first step in operating the system is to "enable power" and "home" the robot. Enabling power
provides power to the motors. Homing establishes the absolute 0 position of each axis so that
previously taught motions can be exactly repeated. Many robots lose track of their axes 0 positions
when power to the controller is turned off. Homing reestablishes the 0 references using whatever
technique is appropriate for the axes, e.g. pressing into a hard stop, engaging a limit switch, reading
special encoder tracks, etc.

As a convenience, power enable/disable and homing buttons are provided on a number of different
web panels (e.g. the Operator Control Panel, the Virtual Manual Control Pendant (VMCP), the
Robot Status section of Edit and Configuration Pages). All of these buttons perform the same
functions. For this example, we will use the Operator Control Panel.

Step Action

1.

Open the Operator Control Panel by clickingOperator >.

If you have started a newly loaded system that has not had all of the configuration data defined, there
will be a number of benign error messages displayed in the "SystemMessages" window.

2.

Click Clear Messages to eliminate the clutter of the old messages (This step is not required to enable
power). Then press Enable to turn on power to the motors.

The System state will transition fromOff: switch on wait toGPL Ready to indicate that motor power
has been successfully enabled.

3. Click Home Robot to establish the zero position for each of the axes. This operation will move the
robot and may take a minute or two to complete.
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When the homing successfully completes, the "Robot homed" field will change to "Yes." Once
completed, homing does not have to repeated until the robot controller is powered down, no matter
how many times motor power is enabled and disabled.

Setup Tutorial 2: Manually Moving the Robot

In many of the following tutorials, you will be required to manually position the robot. GD provides
several ways of accomplish this (e.g. the Red "Free" button on the Air Dispenser, the Virtual Manual
Control Pendant (VMCP), the optional hardware Manual Control Pendant, and the Robot Status
and Mini Jog panel on the Edit and Configuration Pages). All of these methods. provide an
equivalent or subset of the capabilities of the VMCP that will be discussed in this section.

Open the Virtual Manual Control Pendant by clicking Virtual Pendant >.

Figure 6-1: Virtual Manual Control Pendant

The VMCP will appear in its own browser window. The upper section of the VMCP provides a
dynamic display of the robot's current location. The lower area contains the "Jog Control" section
whose modes are summarized in the following table. Prior to jogging the robot, motor power must
be enabled and the robot must be "homed."
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Jog Control Description

Disables Jog Control and permits GD to take control of the robot and automatically move its
axes. This mode should always be selected when you have finished moving the robot in jog
mode.

Moves all of the axes of the robot in a coordinated fashion such that the selected syringe tip
travels in a straight-line path along or rotates about the X, Y, or Z axes of the robot’s world
reference frame.

Similar to World mode except that the reference frame is determined by the selected syringe's
orientation. For example, since the Z-axis of the syringe normally points down, a positive motion
in tool Z will move the syringe down.

Moves individual axes one at a time. Even if an axis is beyond its limit stops, this mode can be
used to drive the axis back into the working range.

Allows one or more axes to be taken out of position control mode to permit the axis to move
freely. For lightweight robots, this allows the operator to grip an axis and manually repositioned
it.

Table 6-1: Jog Control

To move a single axis in manual mode, perform the following procedure:

Step Action

1. Click Jog Control > Joint.

2. Select a joint to move, e.g. Joint 1.

3. Select a slow speed initially, e.g. 10.

4. Move the axis in the positive or negative direction by holding down the + or - keys.

TheWorld and Tool modes operate in the same fashion. The Free mode is a bit different in that
multiple joints can be freed at once and the speed setting is not used. For this mode, each time you
select an axis and press the “+” the axis is freed until you press the “-“ key to place the axis back into
position control mode.

In Joint, World and Tool modes, if any of the "INC" speeds are selected, the robot will move a
discrete increment and then stop instead of moving continuously. If you release the "+" or "-" key
and press it again, the robot will move another increment. This is very convenient for fine positioning
the robot.

Try to move the robot in each of the manual modes and at various speeds to get a feel for the virtual
pendant. When you are done practicing manual control, click Jog Control > Computer. This
disables Jog Control and permits GD to automatically move the robot when required.
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For additional experience, you should try to move the robot using the alternate interfaces, i.e. the
optional hardware Manual Control Pendant, and the Robot Status and Mini Jog panels on the Edit
and Configuration Pages.

Setup Tutorial 3: Teaching the Safe Location

When a Process begins execution and after it is completed, the robot is automatically moved to a
fixed Safe Location. This safeguard helps to avoid inadvertent crashes with obstacles in the
workspace. In addition, some standard operations, such as Purging syringes also move to this
location for the same reason. The Safe Location should be set to a position that is always clear of
obstacles and that generally positions the robot out of the way.

NOTE: The Z height of the Safe Location is particularly important since the robot
moves to the Safe Location by first retracting to this Z height and then moving
horizontally to the Safe Location. So, the Z height should be above the highest
obstacles in the workspace.

Step Action

1.

To define the Safe Location, open Configurations > Robot Motion.
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Step Action

2. Manually position the robot at the location that you have selected for the Safe Location taking special
care in selecting the proper Z height.

3. Click the Teach Safe Point button.

4. When asked to "Record Safe Position," press Yes.

5. If you are asked "File Exists: Okay to Delete," press Yes.

This position will automatically be used whenever the system needs to move the robot to a height or
position that is clear of obstacles and out of the way. To verify the Safe Location, a user can
manually move the robot to another position and then press the "Move Safe Point" button.

Setup Tutorial 4: Teaching the Dispense Heads

While it is permissible to teach a Path and repeat the Path without knowing the dimensions or
mounting position of the syringe heads, this is not the recommended procedure. If GD is taught this
information, if a syringe and needle size changes or if a syringe needle bends, GD can automatically
adjust the robot motions so that the new syringe tip will follow the previously taught Path. In
addition, if two syringes are used, the Nodes taught with one syringe can be easily repeated by the
other syringe.

Step Action

1.

To define the Dispense Heads, open Configurations > Dispense Heads
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Step Action

2.

To simplify training the dimensions and mounting of syringes, you must select a "Reference Point" in
the work cell that does not move. Then, to teach the dimensions and mounting of a different syringe tip,
you only need to position that tip at the same Reference Point and click a button. GD will compute the
required information and will automatically put this data into effect each time the syringe is selected.

NOTE: Once the Reference Point value is taught, it should not be changed. If this value is re-taught
with a syringe tip that is a different size or is mounted in a different position on the robot, it will alter
the result of any syringe tips that are taught with respect to this new Reference Point and any
formerly taught Paths will be incorrect.

Manually move syringe tip #1 to the position you have selected as the "Reference Point."

3. Click Record Ref and Yes to confirm.

4. To compute the initial offset for head #1, without moving the robot, press Rec Offset 1 and Yes to
confirm.

5. If you have a second syringe head, manually position it at the Reference Point.

6. To compute the initial offset for head #2, click Rec Offset 2 and Yes to confirm.

7. Click Save to store the results on the flash disk.

You have now successfully taught the dimensions and mounting information for the dispensing
heads. Whenever you select to use a head, this information will automatically be put into effect by
GD.

If at anytime you either change one of the syringes, adjust the mounting of a syringe clamp or bend
a syringe tip, perform the following procedure to re-train the new dimensions and mounting
information.

Step Action

1. Manually move the syringe tip to the position you have selected as the "Reference Point."

2. To compute the new offset, press Rec Offset for the desired head and press Yes to confirm.

3. Click Save to store the results on the flash disk.
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Setup Tutorial 5: (Optional) Teaching the Purge Locations

To execute the manual Purging sequence later to either test the operation of the syringes or to clear
the needles, the locations where the robot is to purge the syringes must be taught. The purging
operation can be manually initiated from the Operator Control Panel, the left panel of the Edit or
Configuration pages or from the Purge Setup panel. If you do not want to execute purging, this
exercise can be skipped.

Step Action

1.

To define the Purge Locations, open Configurations > Purge Setup.

2. Manually position the robot at the location that you have selected to purge the first syringe.

3. Click Rec Head 1.

4. If you are asked to "Overwrite current position," press Yes.

5. Fill in the purging Time and the height that the robot should Approach the purge location.

6. Repeat for the second syringe head if it is being used.

7. Click Save to store the results on the flash disk.

You have successfully taught the syringe Purge Locations. They will automatically be used
whenever the Purge operation is invoked.To verify the locations, you can manually move the robot
to another position and then press "Move To." To test purging, press "Run Purge."
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Setup Tutorial 6: (Optional) Vision Interfacing and Cal-
ibration

If your system includes PreciseVision, the following procedure must be performed to interface GD to
Vision and to compute the calibration data that translates vision results into coordinates useable by
GD.

Step Action

1.

To access the PreciseVision setup panel, open Configurations > Vision.

This procedure assumes that you have already installed PreciseVision on a PC, connected the
camera, and established the Ethernet link between PreciseVision and your robot controller. If not, refer
to the "Supported Hardware and Software Installation" chapter of the Precise Vision Machine Vision
System Introduction and Reference Manual before continuing this tutorial. 

2. To verify that the communications link is properly working, within PreciseVision, create a Vision
Process named "Gd_test" that only contains a camera Acquisition tool.

3. In the "Vision test Process name field," enter "Gd_test" (without quotation marks) .

4. Click Test Vision.
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If the communication link is operating properly, you will see a new picture in PreciseVision's camera
window. If this does not occur, re-execute the Software Installation processes in the PreciseVision
manual.

If your camera is fixed mounted (i.e. not attached to the robot), perform the following procedure:

Step Action

1. Check the Fixed Mounted radio button.

2.
Manually move the robot to the position that you would like it to move to when GD automatically takes
a picture during a dispensing Process. This should be selected so that the robot and its shadow do not
interfere with the picture.

3. To record this position, press Teach Point and press Save to store the results on the flash disk.

4. Execute the Robot Vision Area Camera Calibration procedure described in the PreciseVision
manual.

If your camera is arm-mounted (i.e. it is attached to the robot), perform the following procedure:

Step Action

1. Check the Arm Mounted radio button.

2.
Manually move the robot so the camera is over the area where you want to perform the calibration
process. It is very important that the Z height be correct so that the camera's field of view is properly
focused. This Z height will be used when GD automatically takes a picture during a dispensing Process.

3. To record this position, press Teach Point and press Save to store the results on the flash disk.

4.

To get step-by-step information on performing an arm-mounted camera calibration, Click Calibration
Setup and follow its instructions.

NOTE: For arm-mounted cameras, if the taught robot position is altered after the calibration is
completed, the calibration will be invalid and must be re-computed.

This completes the PreciseVision setup and camera calibration procedure.
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Application Tutorial 1: Basic Application Example

After having completed the Setup Tutorials, we are now ready to develop our first dispensing
application. In general, the Setup Tutorials will not have to be re-executed unless the tooling or
some element of the work cell is modified.

In the last section of this chapter, the Sample Applications Templates contain four example
dispensing patterns. Print the "Template #1: Sample Square Path" and secure it to the robot's work
surface. This template contains the square dispensing pattern that we will train in this tutorial.

STEP 1:  TEACH THE GLOBAL FRAME

All Node locations are defined relative to a reference frame. In the absence of a special frame,
Node locations are defined relative to theGlobal Frame. The value of this frame can be left
unchanged, but it is good form to always start an application by setting this frame to a meaningful
value. For this tutorial, we will align theGlobal Frame with the X & Y axes drawn on the template. 

Step Action

1.

Open theGlobal Frame definition panel Configuration > Global Frame.

Within GD, frames are defined by specifying three points:  the origin of the frame, a point on the X-axis
and a point roughly on the Y-axis.

Copyright © 2024, Brooks Automation 89



6. Step-By-Step Tutorials Guidance Dispense System
Application Tutorial 1: Basic Application
Example Part Number: 608329 Rev. A

Step Action

2. Execute the frame teaching aid by clicking Teach Frame Wizard and confirm that you want to
continue by clicking Yes.

3. When asked, select the head that you will use during this Wizard by clicking Head_x.

4.
When asked to record the Origin, Point On X and Point On Y, manually position the selected syringe
tip at the points on the template marked "Origin," "POX," and "POY" and click the Record button at
each position.  (As a convenience, the Line button on the Air Dispenser can be used in place of
Record and its Free button can be used to manually position the robot).

5. Click the Save button to store the results on the flash disk.  Respond Yes when asked if it is okay to
delete the existing file.

STEP 2:  CREATE A NEW "PATH" AND TEACH ITS "NODES"

A Path contains a sequence of positions (Nodes) that defines the motion of the syringe tip and
specifies when dispensing is turned on and off. A single Path can only define the actions for a single
syringe head. Normally, Paths are kept relatively short since multiple Paths can be combined into
the final dispensing Process that is executed. Given the simplicity of this example, we only need to
create a single Path to define the desired dispensing operation.

Step Action

1.

Open the Path Editor panel, Edit > Path Editor .
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Step Action

2.

The top of the panel is for managing and defining Paths. The middle right section is utilized when a
Path is defined relative to the results from PreciseVision. The bottom is for managing and defining
Nodes (positions) in the currently selected Path.

We will use a wizard to create the new Path and to create and record the positions of its Nodes. To
create the Path, under Path Files, click New.

3.
A pop-up window will display that asks "Create new path file or Teach new path file?."  Clicking
CreateNew will create a new Path but will not define any Nodes. 

To create the Path and to create and teach the Node positions, click TeachNew.

4. When requested, enter the name of the new Path as "Square" (with no quotes).

5. When prompted, specify the dispense head you will use for training and to dispense by clicking either
Head_1 or Head_2.

6.

The pop-up panel from the teach wizard will now ask you to teach the position for the first Node in the
new Path.

From this wizard, you can teach the positions of Line,Arc, and Break Path Nodes.   Other Node
Types can be inserted later. Also, the Types of the taught Nodes can be subsequently modified.

7.
Using any of the manual control methods, position the syringe tip at P1 on the template. It is normally
easiest to have the syringe tip lightly touch the template. The Z heights of the positions can be adjusted
individually or as a group later.

8. Create the first Node as a Line Type and record its position by either clicking the RecLine button in
the pop-up or clicking the green Line Button on the Air Dispenser.

9. Repeat the process for the other positions, P2, P3, P4, P5 and P6.
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Step Action

10.

Terminate position teaching by clickingQuit. The editor panel should now resemble the following:

Note that although you taught 6 Line Nodes, when displayed, the first Node is a series of straight-line
motions is labeled "LineStrt" and the final Node is labeled "LineEnd." This is automatically done by GD
to make the list of points more understandable.

STEP 3:  EDIT NODE AND PATH PROPERTIES

If you click on a line in Path Points, the Node's position relative to theGlobal Frame is displayed at
the bottom right together with other information about the Node. Currently each Node is a Line
Type and has dispensing turned off.

Using the buttons next to the Node display, you can edit the Path by adding or deleting Nodes,
recording new position values, etc. The "Set Value" button permits a coordinate value to be
changed in a group of Nodes. The "Advanced" button permits a group of Nodes to be copied or
deleted or for new Nodes to be inserted using the teaching method.

Before executing this Path,the user must edit a few properties

Step Action

1. To turn on dispensing at the first Node, in "Path Points," click on "1. LineStrt" and in "Selected Path
Point" data, pull-down the list of options below "Dispense" and select Turn On.
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Step Action

2.

To turn off dispensing at the final Node, in Path Points, click on "6. LineEnd" and in Selected Path
Point data, open the drop-down list of options below Dispense and select Turn Off

To the right of the Dispense drop-down list, you will see theMode and Value fields. These fields have
different interpretations for the different Node Types. For the Line and Arc Nodes, these values
control when dispensing is turned on or off relative to the start or end of the motion. In this example,
since the motions for P1 and P6 overlap slightly, these field can be used to delay turning on dispensing
or to turn it off early.

3.
Modify the parameters that apply to the Path overall.In the PathGlobal data, change the Dispense
Spd and the Trans Spd to 5mm/sec. This reduces the nominal speeds when fluid is and is not
dispensed.

4. Set the Approach and Depart heights to 50mm. This increases that height that the robot will move
above the first and last Nodes when starting and ending the Path.

5.
Set the Z value of theOffset to 10. This will lift all of the Node positions by 10 mm. Once the Path has
been verified, this value can be reduced to obtain the correct distance between the syringe tip and the
surface to properly dispense the fluid.

6. Click the Save Path button to save the changes and respond Yes to the confirmation.

STEP 4:  CREATE THE PROCESS

To assist in debugging, it is possible to execute a single Path directly from the Path Editing panel. 
But, since our entire Process will consist of one Path, we will directly move to creating and
executing the full application.

Step Action

1.

Open the Process Editor panel, Edit > Path Editor.
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Step Action

2. To create the Process, click New.

3. When requested, enter the new process name as "Square_Proc" (without quotation marks) and click
OK to confirm.

4. In Process Files, click on Square_Proc.  In Available Paths, click on Square.

5. To add the Square Path to the Square_Proc Process, click Append.

6. Click the Save button to save the changes to the flash disk, and clickOK to confirm.

This completes the creation of the Process. If we had more Paths to add, they would appear in the
Available Paths list and could be appended as well.

STEP 5:  EXECUTE THE PROCESS

Step Action

1.

Open the Operator Control panel,Operator > .
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Step Action

2.

In order to execute the Process, motor power must be enabled and the robot must already be homed
as indicated in the "Robot Status." In the Select Process area, the overall speed of the robot can be
reduce for testing.

Reduce the speed of all robot motions by clicking the 10% speed button.

3. To inhibit dispensing fluid during testing, check the Disable Outputs box.

4. Select the application to run by clicking on Square_Proc and click the Start to begin execution.

Congratulations!  You have just developed and executed your first dispensing application with
Guidance Dispense.

At this time, we suggest that you try running the application at various speeds and adjusting the Z
height of the Path offset with the dispense outputs enabled until you achieve a good, consistent
dispensed fluid pattern.

For additional practice, you should print out the remaining three examples in the Sample
Applications Templates and program these test patterns as well. Each sheet has the list of Nodes
that should be trained to produce the test pattern.

Application Tutorial 2: Adjusting for Base Shifts and Rota-
tions

This tutorial demonstrates that if the base of a dispensing Path has been shifted and/or rotated, the
Global Frame can be adjusted to compensate all of the Path's Node positions. 

This training example requires that Application Tutorial 1 has already been completed and builds
upon its results.

For any of the sample templates, execute the Process again to verify that the dispensing path is
accurately being followed.

Step Action

1. Shift and rotate the sample template on the work surface and secure it again.
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Step Action

2.

Open theGlobal Frame definition panel, Configuration > Global Frame.

We now need to re-teach theGlobal Frame and realigning it with the X & Y axes drawn on the
template. Since all of the Node locations have been defined with respect to this reference frame, once
theGlobal Frame is updated, all of the Node locations will be automatically compensated.

3. Execute the frame teaching aid by pressing Teach Frame Wizard and confirm that you want to
continue by clicking Yes.

4. When asked, select the head that you will use during this Wizard by clicking Head_x.

5.
When asked to record the Origin, Point On X and Point On Y, manually position the selected syringe
tip at the points on the template marked "Origin," "POX" and "POY" and click the Record button at
each position.

6. Press the Save button to store the results on the flash disk.  Respond Yes when asked if it is okay to
delete the existing file.

7. Execute the Process again and verify that the dispensing path is once again following the pattern on
the shifted and rotated template.
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Application Tutorial 3: Automatic Z Height Adjustment

If your system is equipped with a Z-Contact sensor or similar device that can detect the Z height of a
surface, this tutorial illustrates how this sensor can be used to adjust the Z heights of all of the
Nodes in a Path. When enabled, GD will perform a Z-Search as follows:

l Moves to the "Approach" position above the first Node of a Path.

l Moves down in Z until the sensor is tripped.

l Computes the difference between the first Node's Z position and the detected Z height.

l Moves to the first Node position and all subsequent Nodes in the Path applying the Z correction and the
X/Y/Z offset defined for the Path.

When a Z-Search is performed, the Path Z Offset value is utilized to adjust the height of the Path
after the correction is applied. For example, if the Z Offset is set to 0, after the surface is detected,
the Z height of the first Node would be set to the height of the surface and all subsequent Nodes
would be corrected accordingly. Typically, the Z Offset is set to be equal to the gap desired between
the surface and the syringe tip.

This training example requires that Application Tutorial 1 has already been completed and builds
upon its results.

For any of the sample templates, execute the Process again to verify that the dispensing path is
accurately being followed.

Step Action

1.

Open the Path Editing panel: Edit > Path Editor .

2. Select the Path for the template that you are using for this tutorial.

3. Enable the Z-Search for this path by setting the Search pull-down to Use Probe.

4. For testing purposes, increase the height of the Path so it is well off the surface by setting the Z Offset
value to 10mm.
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Step Action

5. Click the Save button to store the results on the flash disk.  Respond Yes when asked if it is okay to
delete the existing file.

6. Execute the Process again and confirm that the syringe tip contacts the surface and then backs off 10
mm.

7. In the Path Editor, reduce the value of the Z Offset and re-execute the Process until the Path height is
correct and the fluid is being correctly dispensed.

8. To verify that the Z-Search is operating correctly, manually adjust the height of the template and
execute the Process again.

Application Tutorial 4: Repeating a Path in a Grid Pattern

Once a Path has been created, it is very easy to have the Path repeated in a 1, 2 or 3 dimensional
grid pattern. This is useful for dispensing fluid on parts that are stored in a pallet or for repeatedly
stepping a fixed distance and duplicating a dispensing pattern.

NOTE: This training example requires that Application Tutorial 1 has already been
completed and builds upon its results.

For any of the sample templates, execute the Process again to verify that the dispensing path is
accurately being followed.

Step Action

1.

Open the Path Editing panel: Edit > Path Editor .

A Path is always indexed along the major axes of its reference frame. For example, if a Path is relative
to theGlobal Frame, you can step in the positive or negative direction of its X, Y or Z axes. You cannot
step diagonally. However, since you are free to select the orientation of the reference frame for a Path,
this does not impose a significant limitation. By default, the number of "Pallet" indices (Idx) is 1, which
means do it once and don't step.

98 Copyright © 2024, Brooks Automation



Brooks Automation 6. Step-By-Step Tutorials
Part Number: 608329 Rev. A Application Tutorial 5: Using Machine Vision

Step Action

2. Select the Path for the template that you are using for this tutorial.

3. Change the number of Pallet indices (Idx) in X to "2." This will repeat the pattern once by stepping
once in the X direction.

4. To specify an index step size of 25.4mm, change the X Pitch to 25.4.

5. Click the Save button to store the results on the flash disk.  Respond Yes when asked if it is okay to
delete the existing file.

6. Execute the Process to view the results.

Since we are only indexing in one dimension, the order in which we index the X, Y, and Z values is
immaterial. However, if we did specify more than one indexing direction, the "Order" pull-down could
be change to re-order which axis we indexed along first.

This completes the modifications for repeating a Path. 

Application Tutorial 5: Using Machine Vision

If your system is equipped with PreciseVision, the application of machine vision in GD is very
straightforward. PreciseVision dynamically computes the reference frame for a Path and this
reference frame is used in place of all of the components of theGlobal Frame except for its Z
height. If PreciseVision cannot locate the reference frame or if it performs an inspection operation
that indicates that a part is not acceptable, it will return an error that will stop execution of the GD
Process.

After the Vision Interfacing and Calibration tutorial is performed, all communication with
PreciseVision and the translation of all results into coordinates that can be applied to Paths is
automatically handled by GD.

The procedure for developing a vision based dispensing application can be summarized as follows:

Step Action

1. As with the Basic Application Tutorial, start by teaching aGlobal Frame. This reference frame should
be selected keeping in mind that vision will need to generate the same frame.

2. Follow the same procedures as before and create and define dispensing Nodes, Paths and a
Process.
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Step Action

3. After your Process has been debugged, create a Vision Process in PreciseVision that can
dynamically locate and return the same reference frame as theGlobal Frame.

4. Flag any desired Paths to indicate that they are relative to the vision reference frame instead of the
Global Frame.

5. Execute your new vision-based dispensing application.

The new steps in this procedure will be described in this tutorial. Prior to reading this material, you
should familiarize yourself with the basics of applying PreciseVision.

This training example requires that Application Tutorial 1 has already been completed and builds
upon its results.

For any of the sample templates, execute the Process again to verify that the dispensing path is
accurately being followed.

In this tutorial, pictures of the Square template will be presented for illustrative purposes, but any of
the other templates can be used as well. To mimic the manual training of theGlobal Frame, we will
be training vision to locate the positions of the lines drawn on the template for the X and Y axes.  In a
real application, coordinate axes are rarely present. Instead, features such as distinct edges with an
included corner or fudicial marks can be selected for both the manualGlobal Frame definition and
the automated vision identification.

Start by illustrating how PreciseVision is trained to locate the X and Y axis lines.

Step Action

1. Position the dispensing template below the camera. It is not necessary to accurately position the
template in the camera's field of view. All that is required is that a portion of the X & Y axes are visible.

2. If the camera is mounted on the robot, ensure that its Z height is the same as the calibration point in the
GD Vision panel. You can useMove To on the Vision panel to correctly set the Z height.
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Step Action

3.

Using PreciseVision, take a picture by selecting File > Acquire New Image.

4. In PreciseVision, create a new Vision Process named "Xy_axes_frame."

5. Create and add to this Vision Process an Acquisition Tool followed by a Line-Line Frame Tool.

6. Create two Line Fitter Tools and provides these as the inputs to the Line-Line Frame Tool.

7.

Position the first Line Fitter to locate the X-axis and the second Line Fitter to locate the Y-axis of the
template.
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This Vision Process will take a picture and determine the two lines that best fit the X and Y axes of
the template. Then, a reference frame is computed whose origin is the intersection of the two line
fitters and who's X-axis is aligned with the results of the first Line Fitter.

This completes the vision training. The Xy_axes_frame Vision Process can now be executed by
Guidance Dispense whenever the template reference frame needs to be located.

Returning to Guidance Dispense, we must now mark the dispense Path as being relative to the
vision results in place of all of the components of theGlobal Frame except for its Z height.

Step Action

1. Open the Path Editor by clicking Edit > Path Editor

2. Select the Path for the template that you are using for this tutorial.

3. Flag this Path as being relative to a vision result by checking Use Vision.

4.

Specify the Vision Process to be executed to locate the reference frame by entering "Xy_axes_frame"
(without quotation marks) into the Process Name field.

5. The Vision Tool Name can be left blank since we just want the results from the last vision tool that is
executed, the Line-Line Frame tool.

6.
If the camera is mounted on the robot and you want to move the camera to a position other than the
point where the camera was calibrated, manually move the camera to the correct position and Z height
and press Record.

7. Click Save to store the results on the flash disk.
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This completes the extra steps necessary to develop a vision based dispensing application! Your
previously created Process can be executed as before. As a test, try displacing and slightly rotating
the template to verify that the Path is being dynamically updated.
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Sample Application Templates

The following are a series of sample Paths. These should be printed out and used in connection
with the Tutorials presented earlier in this Chapter.

Figure 6-2: Template #1: Sample Square Path
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Figure 6-3: Template #2: Sample Circle Path
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Figure 6-4: Template #3: Sample Parallel Line Path
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Figure 6-5: Template #4: Sample Pill Path
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7. Reference Information

Dual Control Air Dispenser Pneumatic Connections

The Dual Control Air Dispenser controls the air lines for the two syringes and the pneumatic
actuator for the vertical slide for the first syringe clamp. For each syringe, this device provides two
pressure regulators:  one to control the positive pressure utilized to dispense the fluid from the
syringe and a second regulator that supplies air to a venturi device that creates a vacuum in the
syringe air line when the positive pressure is turned off. The vacuum assists in withdrawing the
syringe plunger to minimizing dribbling of the dispensed fluid.

The picture below illustrates the pneumatic inter-connections between the components of the Dual
Control Air Dispenser.

Figure 7-1: pneumatic inter-connections
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The external air pressure input line is on the right of the unit. This air is provided to the four
regulators and flows to the left to the hose for the Syringe Clamp Slide Solenoid Valve. The Syringe
#1 & #2 regulators provide reduced air pressure to the Syringe #1 & #2 Solenoid Valves. The
Syringe #1 & #2 VAC regulators provided reduced air pressure to the Syringe #1 & #2 Venturi
components.  The Venturi units convert the positive air pressure into a vacuum that is provided to
the negative side of the Syringe #1 & #2 Solenoid Valves.

Dual Control Air Dispenser Electrical Connections

The Dual Control Air Dispenser requires a number of electrical connections for the proper operation
of this unit.  These interfaces include the following:

l Three 24 VDC input signals into the Air Dispenser that operate the three solenoid values (Syringe #1 &
#2 Valves and the Syringe Clamp Slide Valve).

l Three dry contacts in the Air Dispenser that indicate if any of the buttons are being clicked (Red Free,
Green Line and Blue Arc momentary contact buttons).

l Three 24 VDC input signals into the Air Dispenser that turn on the back lights of the three buttons.

l One sensor output signal from the Air Dispenser that is generated by the Z-Contact sensor on the
Sliding Syringe Clamp.

All of these signals are connected to four-pin 3M 37104 series Mini-Clamp Plugs.

Figure 7-2: Four-Pin 3M 37104 Mini-Clamp Plug

The following tables describe how each of the signals are wired to their respective plugs.

Pin Push Button with Back Light Wire Color

1 GND Black

2 24 VDC supplied to turn on back light.  Returned through pin 1. Gray

3 24 VDC returned by dry contact switch when button clicked. Green

4 24 VDC power supplied to dry contact switch. Red

Table 7-1: Signals & Plugs
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Pin Solenoid Valve Control Wire Color

1 GND Black

2 24 VDC supplied to open valve.  Returned through pin 1. Red

3 N.A. Not connected

4 N.A. Not connected

Table 7-2: Signals & Plugs

Pin Z-Contact Sensor Wire Color

1 GND Blue

2 N.A. Not connected

3 24 VDC returned by sensor when contact detected. Black

4 24 VDC power supplied to sensor. Brown

Table 7-3: Signals & Plugs

Interfacing to PrecisePlace Robots

If the Dual Control Air Dispenser is interfaced to a PrecisePlace robot, the electrical connections
from the Dispenser should be plugged into the Digital I/O signals provided in the Z-Axis IO board. 
This board is mounted beneath the cover for the Z-axis motor. The following is a picture of the
Z=Axis IO board.

               Electrical Shock Hazard

The Z-Axis IO board contains an optional motor connector that provides a bus voltage of
320 VDC. As such, this board represents a high-risk and should only be accessed when
the main AC power to the robot is disconnected.
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Figure 7-3: Z=Axis IO Board

The following table defines where each of the Air Dispenser plugs should be connected to the Z-
Axis IO board.

DIO Connector GPL Signal Number Air Dispenser Plug

1 33 / 10033 Red Free button

2 34 / 10034 Green Line Button

3 35 / 10035 Blue Arc Button

4 36 Syringe Clamp Slide Solenoid Valve

5 37 Syringe #1 Valve

6 38 Syringe #2 Valve

7 10039 Z-Contact Sensor

8 No used

Table 7-4: Air Dispenser Plugs & Z-Axis IO Board Connection
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8. Troubleshooting Guide

Guidance Dispense Common Error Messages

The following table contains common error messages and pop-up messages that you may
encounter during the normal operation of the Guidance Dispense system. See the PreciseFlex
Library → Controller Software → Software Reference → System Error Codes for a description
of the complete list of error messages that can be generated by the robot control system.

Error Description Corrective Action

Error Messages
-1006,
*Robot
already
attached*

Can occur when trying to record a
position that requires that the dispensing
head dimensions be set but another task
has control of the robot.

The most common problem is that the virtual MCP is not in
Computer mode and is controlling the robot.   Be sure to set
the virtual MCP to computer mode.

-1046,
*Power not
enabled*

Can occur any time in response to a
request to execute a dispensing
Process, Path, Move Safe, Retract Arm
or other robot motion.

Before the robot can be moved, motor power must be
enabled.  Check that the "System state:" displays "GPL
ready" before attempting to move the robot.

-1047,
*Virtual
MCP in
Jog mode*

Can occur any time in response to a
request to execute a dispensing
Process, Path, Move Safe, Retract Arm
or other automatic robot motion.

The system cannot be in jog mode when attempting to move
the robot automatically. Take the system out of jog mode by
clicking on the "Comp" button in the "Robot Status" under
"Edit" or the "Computer" button in the Virtual Pendant.

-4000,
*Cannot
connect to
vision
server*

Can occur in response to a request to
execute a dispensing Process or Path
that uses PreciseVision to locate an
object.

Before a vision process can be executed, PreciseVision must
be running on a PC. The PC IP address must be set in the
"Vision Configuration" page.

Vision
Operation
Failed

During execution of a dispensing
Process that contains a request to locate
an object using PreciseVision, the
PreciseVision process has failed due to
one of its vision tools not obtaining the
expected results.

Check the PreciseVision camera window to see if the proper
object is inside the field of view.

Check to see if the proper PreciseVision project is loaded for
the dispensing Path being executed.

Check to make sure the proper lighting is set and on.
Pop up messages

Table 8-1: Error Messages

112 Copyright © 2024, Brooks Automation



Brooks Automation 8. Troubleshooting Guide
Part Number: 608329 Rev. A Guidance Dispense Common Error Messages

Error Description Corrective Action

Last
Command
Still Busy
...

Message occurs when clicking on a
button or selecting an item in a list in the
graphical user interface.

This indicates that the web interface is still processing the last
request while a new one is being requested. Only a single
request can be performed at a time in the web interface.

Try performing the operation again.

If this continues to happen for all requests and the robot is
idle, make sure the GPL project is loaded and running. See
the PreciseFlex Library for details on the GuidanceWeb
Interface. Use the GuidanceWeb interface operator control
panel to determine if the "GDispense" project is loaded and
running.

Changing
points too
quickly.

Message occurs when selecting points in
the path editor.

When a Path node is selected, the web page retrieves the
information from the controller and updates the data fields.
This operation cannot be interrupted and must be completed.

If this message continues to be displayed, try slowing down
between selection of points. If the web pages seem to be
updating very slowly, check with your network administrator
as there could be a problem with the network traffic.

Busy ... Message never goes away at bottom of
web panels.

While the robot is executing a Process or Path, the "Busy ..."
indicator will be displayed.

If the indicator never goes away, it could indicate that the
GPL project "GDispense" is not executing. See the
PreciseFlex Library for details on the Guidance Web
Interface. Use the Guidance Operator Control panel to
determine of the "GDispense" GPL project is executing.
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